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B

Wprowadzenie

do éwiczenia

1. Cel i przebieg ¢wiczenia

Celem tej cze$ci ¢wiczenia jest obserwacja pracy tranzystora MOSFET mocy w jego typowej
aplikacji, jaka jest przetwornica pradu stalego. W ukladzie tym tranzystor stanowi czes¢
polprzewodnikowego lgcznika dwupozycyjnego, przelaczajacego prad z jednej gatezi do drugie;j.
Przetwornica umozliwia poznanie impulsowej metody sterowania przyrzadéw polprzewodnikowych
mocy.

Cwiczenie pokazuje, ze technika ukladéw przelaczanych z wykorzystaniem tranzystoréw mocy
pozwala na realizacje pozytecznych funkcji w uktadach stalopradowych, przy wysokiej sprawnosci
energetycznej. Jak zawsze, zwigzane sg z tym jednak pewne ograniczenia, w czym znaczacy udziat
ma lacznik poélprzewodnikowy. Na koniec jego wlasciwosci zostana powigzane z wilasciwoséciami
przetwornicy.
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2. Przetwornice pradu stalego

2.1. Przeksztaltniki DC-DC

2.1.a. Obszar zastosowan

Ukladem badanym w tej czesci ¢wiczenia jest przetwornica dlawikowa pradu stalego obnizajaca
napiecie. Przypomnijmy, ze przetwornice pradu statego zaliczaja si¢ do elektronicznych ukladow
przeksztaltnikowych i stanowig zasadniczg rodzine ukladow w klasie przeksztaltnikoéw DC-DC.

Okreslenie ,pradu stalego” odpowiada angielskiemu direct current, ktére moze sie odnosié¢ do
dowolnej wielkosci elektrycznej — nie tylko pradu. W przypadku przeksztaltnika wskazuje ono na
to, z ktorg skladowa (stala czy przemienng) napiecia i pradu zwigzana jest decydujaca czesé
przekazywanej mocy. W przetwornicach pradu statego jest to wigc skladowa stala. Wielkoscia
faktycznie przetwarzang nie musi by¢ jednak prad. Wrecz przeciwnie — w duzej czesci przypadkow
praktycznych przetwornice sg zasilane ze Zrédla napiecia i ich wyjscie ma réwniez charakter zrédia
napiecia (stale napiecie, niezalezne od pradu). Taki przypadek bedziemy bada¢ w niniejszym
¢wiczeniu.

Z przetwornicami pradu statego stykamy sie codziennie. Stanowia one podstawowy sktadnik
zasilaczy impulsowych (np. komputerowych), ladowarek oraz niektérych ukladéw sterowania
silnikow pradu stalego. Moga by¢ tez wykorzystywane w $ciemniaczach lamp fluorescencyjnych
(swietlowek) i halogenowych.

Przeksztalcanie energii DC-DC mozna realizowa¢ nie tylko za pomoca przetwornic - tj. ukladow
przelaczanych. Istnieja rowniez przeksztattniki DC-DC o dzialaniu ciaglym. Sa one wykorzystywane
glownie w zasilaczach. Ich gléwna zaleta jest niski poziom zaburzen w napieciu wyjsciowym. Wadg
natomiast — jak wykazemy wkrétce — mala sprawnos$¢ i konieczno$¢ odprowadzania duzej ilosci
ciepta.

2.1.b. Przetwornice dtawikowe

Najprostsza pod wzgledem topologii i zasady dzialania grupa przetwornic sa przetwornice
dlawikowe. Kazdy uklad z tej grupy zawiera co najmniej 4 elementy:

1) przyrzad polprzewodnikowy sterowalny,
2) przyrzad pdlprzewodnikowy niesterowalny,
3) dlawik,
4) kondensator.
Dtawikiem (ang. choke) nazywamy cewke (ang. coil) z rdzeniem wykazujaca:

1° znaczng reaktancje dla czestotliwosci pracy (przetaczania) przetwornicy — w
zwigzku z tym blokuje ona sktadowa przemienng pradu
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8+B2 Przyrzady i uktady mocy — Cwiczenie 3B. Tranzystory MOSFET (6.8.0)

2° 1niskg rezystancje — w zwigzku z tym przepuszcza ona skladowg stalg pradu.

Laczac powyzsze 4 elementy w rézny sposéb mozna uzyskac 3 podstawowe uklady o réznych
funkcjach:

1) obnizajacy napiecie,
2) podwyzszajacy napiecie,
3) odwracajacy napiecie (i podwyzszajacy zarazem).
Taki wlasnie prosty uktad jest obiektem badan w niniejszym ¢wiczeniu. Trzeba jednak wiedziec,
ze czesto dla uzyskania wymaganych parametréw pracy przetwornicy konieczne jest zastosowanie
uktadu bardziej skomplikowanego, co moze oznacza¢ np. dodanie obwodu sprzezenia zwrotnego,

obwodoéw  zabezpieczen, transformatora separacyjnego czy  wejSciowego filtru
przeciwzakldceniowego.

Zanim przejdziemy do wyjasnienia dzialania badanego ukladu, przedstawimy ogdélna idee
przetwornic pradu stalego i metody ich sterowania, zwanej sterowaniem impulsowym. Dokonamy
tego w oparciu o najprostszy uklad impulsowy — przeksztalcajacy energie zwigzang z pewnym
stalym napieciem wejSciowym U; na energie zwigzang z mniejszym napieciem wyjsciowym Ub.
Uklad taki posiada swoje odpowiedniki o dziataniu ciaglym, dzigki czemu bedziemy mogli pokazac¢
zalety plynace z techniki impulsowe;j.
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Przetwornice pradu stalego B2+9

2.2. Uktady o dziataniu ciagtym

2.2.a. Przeksztattnik elektromechaniczny

Najprostszym i pierwszym znanym przeksztattnikiem DC-DC jest ukiad elektromechaniczny.
Stanowi go zwykly opornik nastawny R, wlaczony w szereg w obwod mocy (rys. la). Pod
wzgledem topologii jest to wiec uklad identyczny jak elektromechaniczny przeksztaltnik AC-AC
(twiczenie 2).

Zwiekszajac warto$¢ opornika, powodujemy odkladanie sie na nim coraz wiekszej czesci
napiecia wejsciowego — za$ coraz mniejsza cze¢$¢ dostepna jest dla odbiornika zgodnie z zaleznoscia

RL RP B
U,=U,—L—=U,|1+-L (2.1)
R, +R, R,

Uzyskujemy wigc zmniejszenie napiecia w stosunku, ktéry nazywany jest wspotczynnikiem
przetwarzania napiecia (ang. voltage conversion ratio)

AU,
Ky = U (2.2)
W rozwazanym przypadku
K 1 i i (2.3)
= + — .
U R,

Uklad z opornikiem ma charakter dzielnika napiecia. A wigc nastawa napiecia wyjsciowego
zalezy faktycznie nie od wartosci opornika R, jako takiej, lecz od stosunku tej wartosci do
rezystancji odbiornika Ry — co pokazuje powyzszy wzor. Jezeli odbiornik zmienia swoja rezystancje
w czasie pracy (co przy stalym napieciu oznacza po prostu wigkszy lub mniejszy pobér pradu), to
napiecie na nim bedzie si¢ roOwniez zmienia¢. Stosowalno$¢ uktadu z opornikiem jest wiec w
zasadzie ograniczona do obcigzen stacjonarnych. Tymczasem duza cze$¢ odbiornikéw taka nie jest -
np. telefon komérkowy pobiera duzo wiecej mocy (a wiec pradu, gdyz napiecie zasilania jest stale) w
trakcie rozmowy, niz w stanie oszczedzania energii.

Dodatkowo sprawno$¢ tego rozwigzania jest w duzym zakresie sterowania niewielka, co
wykazaliSmy juz w ¢wiczeniu 2. Wynika to z koniecznosci odlozenia na oporniku calej réznicy
miedzy napieciem wejsciowym a wyjsciowym

U, =U, -U, (2.4)

Jezeli obciazenie (prad wyjsciowy L, przy czym w tym uktadzie I, = [;) jest znaczne, to bedzie to
zwigzane z cigglym wydzielaniem w przeksztaltniku (oporniku) znaczacej mocy

AP, =U.I,=U, -U,)I, (2.5)

Sprawnos$¢ przeksztaltnika elektromechanicznego jest tym nizsza, im wigksza rdéznica
napiec (a wiec im bardziej chcemy zmieni¢ napiecie):

°© =K, (2.6)
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10+B2 Przyrzady i uktady mocy — Cwiczenie 3B. Tranzystory MOSFET (6.8.0)

Zalézmy dla ustalenia uwagi, ze U; = 20 V, pozadane napiecie wyjsciowe U, = 10 V, obcigzenie
I, =1 A. Wobec tego Ky = 0,5, a rownowazna rezystancja odbiornika Ry, = U, / I, = 10 Q. Na oporniku
nastawnym musi si¢ odtozy¢ napiecie o wartosci 20 V - 10 V = 10 V. Moc w nim tracona jest rowna
10V-1A=10W, co stanowi polowe mocy wejsciowej 20 V - 1 A = 20 W. Sprawno$¢ wynosi wiec
zaledwie 10 W/ 20 W = 0,5. Wynika to zreszta rowniez wprost z wyprowadzonego wyzej wzoru
(2.6).

zZredto (D Ay U RL H Odbiornik

b) ) Uc
|i |0:II

Zrédto C) f U U Sterowanie J Uo RL

1

} Odbiornik

A X(Z | |
Zredto (D AU SferowanieJ w' | Filte | RLH Odbiornik
Uo'(av)

Rys. 1. Przetwarzanie energii prqdu statego: a) przeksztattnik elektromechaniczny;
b) przeksztattnik elektroniczny; c) elektroniczny przeksztattnik przelqczany
z uwzglednieniem filtru wyjsciowego

2.2.b. Uktad elektroniczny o dziataniu ciagtym

Duzy postep dokonat si¢ dzieki wynalezieniu tranzystorow bipolarnych zlaczowych (B]T)
mocy i opracowaniu odpowiednich ukltadéw o dzialaniu ciaggtym. W takich ukiadach w szereg w
obwo6d mocy wlaczony jest tranzystor (jego obwodd kolektor-emiter; rys. 1b). Dostarczajgc do
tranzystora odpowiedni prad sterujacy (bazy) Iz, mozna powodowaé przeptyw wiekszego lub
mniejszego pradu kolektora Ic, ktory — jak wynika ze schematu - rowny jest pradowi wyjsciowemu
przeksztattnika I, W wyniku uzyskujemy zmiane napigcia wyjsciowego zgodnie z prawem Ohma

U,=R.1, =R I. =R By (2.7)

gdzie fr jest statycznym wzmocnieniem pradowym tranzystora w ukladzie wspolnego emitera
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Przetwornice pradu stalego B2+11

_Ie
B =7 (2.8)

B

Poniewaz dokonuje sie to za pomoca sygnatu elektrycznego (a nie mechanicznego jak w
przypadku opornika nastawnego), mozna zrealizowaé elektryczne sprzezenie zwrotne. Mierzac i
odpowiednio przetwarzajac napiecie wyjsciowe, mozna spowodowac takie zmiany pradu bazy, ze
napiecie to bedzie utrzymywane na staltym poziomie — mimo zmian rezystancji odbiornika lub takze
napiecia wejsciowego. Uklady tego typu nazywamy stabilizatorami napiecia o dzialaniu
cigglym (ang. linear voltage regulators).

Powyzsze obowigzuje jednak wylacznie dla pracy tranzystora w zakresie aktywnym. Tylko
wowczas tranzystor moze pelni¢ role sterowanego zrddla pradu, tzn. przewodzi¢ prad bedacy
funkcja wytacznie wielkosci sterujacej (Ig), a niezalezny od napiecia wyjsciowego (Ucg). Oznacza to
prace posrodku obszaru charakterystyk wyjsciowych Uce—Ic, a wiec przy jednoczesnych znaczacych
warto$ciach pradu i napiecia — a w konsekwencji, przy duzej mocy strat.

Do tego wniosku mozna zreszta doj$¢ prosSciej. Zauwazmy, ze na tranzystorze musi si¢ ciagle
odkiada¢ dokladnie takie samo napiecie, jak w ukladzie z opornikiem - wyrazajace sie rownoscia
(2.4). W zwiazku z tym, w takich samych warunkach pracy (U, Us, I,) moc strat w tranzystorze
jest dokladnie taka sama, jak w oporniku nastawnym, a sprawno$¢ nadal wyraza sie wzorem (2.6).
Dla rozwazanego przypadku liczbowego wynosi wiec ona 0,5.

Uklady elektroniczne o dziataniu cigglym umozliwiaja wiec automatyczng regulacje wyjscia. Nie
likwiduja jednak wady polegajacej na ciaglej koniecznosci odlozenia na elemencie wykonawczym
(poprzednio — oporniku, obecnie — tranzystorze) calej réznicy napie¢ miedzy wejsciem a wyjsciem,
przy cigglym przeplywie pradu z wejscia do wyjscia. Oznacza to ciagle wystepujace straty mocy w
tranzystorze, w tym samym rozmiarze, co w przypadku opornika. Oznacza to nie tylko obnizenie
sprawnosci, ale jednoczesnie problemy z chlodzeniem elementu wykonawczego (tranzystora).
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12+B2 Przyrzady i uktady mocy — Cwiczenie 3B. Tranzystory MOSFET (6.8.0)

2.3.  Przetwornice impulsowe

2.3.a. Sterowanie impulsowe

Oba problemy - regulacji i sprawnosci — mozna rozwiaza¢ dopiero z wykorzystaniem techniki
ukladow przelaczanych. Jezeli tranzystor bedzie przez cze$é czasu w pelni zalgczony (z jak
najnizszym spadkiem potencjalu na nim), a przez cze$¢ - w pelni wylaczony (z prawie zerowym
przeplywem pradu), to moc strat zostanie znacznie ograniczona.

Uzyskanie takiego dzialania ukladu wymaga sterowania nie ciaglego, ale impulsowego. W
sterowaniu impulsowym wielkos¢ sterujaca x (prad, napiecie) ma posta¢ przebiegu impulsowego
(ang. pulse wave). Sklada sie on z powtarzajacych sie okresowo impulséw (ang. pulses), tj. odcinkow
0 poziomie wyzszym niz spoczynkowy, ktorych ksztalt mozna w uproszczeniu rozwazaé jako
prostokatny (patrz rys. 2a).

Przebieg impulsowy opisuje si¢ za pomoca nastepujacych parametrow:

1) okres powtarzania T, (ang. period of repetition) — to oczywiscie najkrotszy czas,
po ktorym przebieg wykazuje powtarzalnos¢, a wiec jaki uptywa np. miedzy
poczatkami kolejnych impulsow;

2) czestotliwos¢ powtarzania f, (ang. frequency of repetition) — to odwrotnos¢
okresu powtarzania

Jo =7 (2.9)

3) czas trwania t, (ang. pulse width) — to dlugos¢ grzbietu impulsu;

4) wspolczynnik wypetnienia impulsow D (ang. duty cycle, duty ratio) - to
stosunek czasu trwania do okresu powtarzania:

D=2" (2.10)

Jak tatwo zauwazy¢, do jednoznacznego opisu przebiegu impulsowego w dziedzinie czasu wystarczy
jeden z parametrow 1-2 i jeden z parametréw 3-4.

W dziedzinie danej wielkosci elektrycznej (pradu lub napiecia), przebieg impulsowy opisuja:
5) poziom niski X1 (ang. low level) — to warto$¢ wielkosci x odpowiadajaca
podstawie impulsu (ang. pulse base);
6) poziom wysoki Xu (ang. high level) - to wartos¢ wielkosci x odpowiadajaca
grzbietowi impulsu (ang. pulse top);

7) amplituda X (ang. amplitude) - to odlegtos¢ miedzy poziomem niskim a
wysokim

X, =X, -X, (2.11)

Jak latwo zauwazy¢, do jednoznacznego opisu przebiegu wystarcza dowolne dwa z parametrow 5-7.

W elektronice mocy bardzo czesto spotyka si¢ przebiegi o zerowym poziomie podstawy (XL = 0),
dla ktorych Xu = Xm. Ze wzgledu na czestos¢ wystepowania tego przypadku, a jednoczesnie znaczne
uproszczenie otrzymywanych zaleznos$ci, zwykle w analizie sterowania impulsowego przyjmuje sie
wlasnie zerowy poziom podstawy.

Powyzsze parametry opisuja w pelni jedynie impulsy idealne. W elektronice mocy najczesciej
uwzgledniang cecha rzeczywistego przebiegu impulsowego jest niezerowa dlugos¢ zboczy (ang.
edges). Zbocza te opisuje sie za pomocg (zob. rys. 2b):
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Przetwornice pradu stalego B2+13

8) czasu narastania t; (ang. rise time) — tj. czasu, jaki zajmuje naro$niecie
przebiegu od 10% do 90% jego amplitudy, ktory jest miarg czasu trwania zbocza
narastajqcego czyli czota impulsu (ang. rising edge, leading edge);

9) czasu opadania t; (ang. fall time) — tj. czasu, jaki zajmuje opadniecie przebiegu
od 90% do 10% jego amplitudy, ktory jest miara czasu trwania zbocza
opadajqcego czyli spadu impulsu (ang. falling edge, trailing edge).

Inne nieidealnosci (np. przerzuty, czas ustalania odpowiedzi, fluktuacje fazy) nie maja z reguly
wplywu na makroskopowe dzialanie przeksztaltnikow modelowych (akademickich, idealnych).
Dlatego zostang one przez nas zaniedbane. Ich uwzglednienie staje sie natomiast konieczne na etapie
optymalizacji ukladow fizycznych (rzeczywistych), w ktorych moga powodowac niepozadane
zjawiska mikroskopowe niekorzystnie oddziatujace na calosciowe dzialanie uktadu.

a) x“
X | gt -
XITI
x poa | M | I . t
t,= DT, g |
E< Tp - 1/fp >i< Tp =:
b) <4
X, grzbiet
X +90% X,
X +50% X,
X +10%X, 1.\
XL o i H H ’
b P t
i = DT, §
B T,=1/f, N

Rys. 2. Przebieg impulsowy i jego podstawowe parametry: a) przebieg idealny; b) przebieg o skoriczonej stromosci
zboczy

2.3.b. Przeksztaltnik elektroniczny o dziataniu przetaczajacym

Powr6¢my teraz do rozpatrywanego przykladu przetwarzania energii elektrycznej. Zasadniczo
topologia przeksztaltnika pozostaje niezmieniona (rys. 1b). Zmienia sie jedynie ksztalt przebiegu
sterujacego (w tym wypadku pradu bazy). Czestotliwos¢ powtarzania impulsow f, tego przebiegu
narzuca oczywiscie czestotliwos¢ przelqczania ukladu f; (ang. switching frequency) i okres
przelgczania uktadu T; (ang. switching period):

fs===17 (2.12)

1
N

Zalézmy, ze czestotliwos¢é przelaczania jest stala i wynosi f; = f, = 100 kHz. Wowczas okres
Ts = 10 ps. Niech wspolczynnik wypetnienia wynosi D = 0,5, stad #, = 0,5 - T, = 5 ps (powdd takiego a

nie innego wyboru wartosci D stanie si¢ wkrotce jasny).
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Zalézmy tez, ze parametry tranzystora rozpatrywanego jako lacznik poétprzewodnikowy sa
nastepujace: napiecie w stanie zalaczenia Usn = 1V, prad w stanie wylgczenia L = 0, czas narastania
i czas opadania (pradu glownego) tisw) = tisw) = 0,5 ps. Indeks ,sw” (switch) zostal dodany, aby
unikna¢ pomylki z parametrami przebiegu sterujacego, o ktérym zakladamy, iz jest idealny, tj.
tr=tr=0. Jak widaé, wartoSci parametrow lgcznika (Uon, &, ) zostaly przyjete raczej jako
maksymalne z mozliwych (a wiec najgorsze) w stosunku do wspdlczesnie uzyskiwanych (zob.
instrukcja 0, par. 4.5).

Y

A
A

UA

c

U=20V

U/2=10V

C
Il
<

\ 4

> tr(sw) = 0’5 “S

tf(sw) = 015 HS

<
<

o — —— i ————

Y

10 W A

\ 4

U =20V
U~U, =19V—

U/2=10V |
Uy = 9,5 V-]

\ 4

Rys. 3. Przebiegi wielkosci elektrycznych w uktadzie przetwornicy obnizajqcej przy zatozeniu: U; = 20 'V,
Uo=10V,RL =109, f, = 100 kHz, Uon = 1V, tisw) = tisw) = 0,5 pus (w przypadku przebiegu u, czasy te
zaniedbano): linia kreskowa — uktad o dziataniu cigglym; linia ciggta — uktad o dziataniu przelqczajgcym
(sterowanie impulsowe)

Przebiegi w ukladzie z rys. 1b w obu przypadkach sterowania - ciaglego i impulsowego,
przedstawiono na rys. 3. W pierwszym przypadku przebieg sterujacy i jest staly, a jego poziom
wynika z koniecznos$ci uzyskania pradu 1 A i spadku potencjalu 10 V (patrz paragraf 2.2.b). W
drugim przypadku prad ip ma przebieg impulsowy i dzieli okres przelaczania na dwa takty:
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1) tranzystor zalaczony - wowczas uc = Uon = 1 V (zgodnie z zalozeniem), wiec
Uo = Ui - Uon = 19V, za§ w obwodzie plynie prad i, = uo/RL = 1,9 A. Przeptyw
tego pradu powoduje rozpraszanie w tranzystorze mocy o wartosci
Ape = Uonio = 1,9 W;

2) tranzystor wylaczony — wowczas i, = Lt = 0 (zgodnie z poczynionym wyzej
zalozeniem, prawie zawsze uprawnionym), a wiec rowniez u, = Rri, = 0 (do
wartos$ci tej wrocimy w paragrafie 2.3.d). Spadek potencjatu na tranzystorze
wynosi wiec 20 V, jednak z powodu zerowego pradu chwilowa moc strat
Ape = 0.

Jak wida¢, w stosunku do ukladu o dzialaniu ciggltym, moc strat w tranzystorze zmalata o rzad
wielkos$ci — zamiast 10 W wydzielanych ciggle mamy 1,9 W wydzielanych tylko przez polowe czasu.

2.3.c. Analiza energetyczna

Dla dokladnego rachunku nalezaloby uwzgledni¢ dynamiczne straty mocy. W celu ich
oszacowania mozna przyblizy¢ przebiegi napiecia i pradu podczas przelaczania tranzystora
odcinkami prostymi. Wowczas (patrz instrukcja 34, par. 3.3):

— moc chwilowa Ap. jako iloczyn pradu i, i napigcia u. mie¢ bedzie ksztalt wycinka
paraboli o wartosci maksymalnej Usgtlon/4 (zob. rys. 3);

— pole pod ta parabola jest rowne (przyjmujac Usn ~ 0) (1/6)-Uotr-Ion-t: dla zalaczania i
(1/6)- Ustr- Ion- tr dla wylaczania.

Oczywiscie parametry & 1 & w powyzszych zaleznoSciach odnosza sie do obwodu gléwnego
tranzystora, nie do przebiegu sterujacego.

Przy zalozonych wyzej warto$ciach liczbowych otrzymujemy:

1° dla stanu zalgczenia energia tracona

Uu,-U
W 1 on

o = JApedr = Jugidr=U,, (1, =1,)=1VO9A H5us =8,6 W
t, -t

1=t L
2° dla stanu wylgczenia energia tracona (przy zalozeniu zerowego pradu)

W,=  [Apdt= [uidi=U OQT, -1, -t —1,)=0]

T,—t, =t ~1 [ A A
3° stad moc czynna strat statycznych

AP — Wcond + Wb — Wcond — 8’6 l“"‘]
et T T. 10 s

S S

=086 W

4° dla stanu zalaczania energia tracona

W, =[Ap.dt=1U 1 7, =L20VOIADSps=32pJ

off “on"r
I

r

5° dla stanu wylaczania energia tracona

Woe = [Apdt =+U o 1 1, =220V AD,5us =32 )
Ig

6° stad moc czynna strat dynamicznych

+W . +
AP, = Won *Worr _ 3.2 +3.2 ]
T 10 us

S

=0,64 W
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16+B2 Przyrzady i uktady mocy — Cwiczenie 3B. Tranzystory MOSFET (6.8.0)

7° ostatecznie catkowita moc czynna strat w tranzystorze spadla (w stosunku do
ukladu o dziataniu cigglym) do wartosci

AP, = AP,

c,stat

+AP ., =086 W +0,64W=15W

c,dyn

Rozmiar spadku mocy strat wizualnie przedstawia zaznaczone na szaro pole na rys. 3. Jest to
roznica pol powierzchni pod przebiegiem mocy chwilowej dla sterowania ciaglego i dla sterowania
impulsowego - a wiec réznica energii wydzielanej w tranzystorze w jednym i w drugim przypadku.

Zauwazmy, ze moc czynna wejsciowa nie zmienila si¢ znaczaco i nadal wynosi ok. 20 W, gdyz

U, It It
R=i{%mu:iU1jgm+ fotae+ [ide+[i,de | =5 1,1, +0+=2+ 2L | =
Tp T Tp to—t T, —t,—t.~t; t t, TP 2 2
=2‘v@QABwM“ﬂ+L9Am5m+L9Am5wj=2OV®5Amgﬂ9W
10 pus 2 10 pus

gdzie calki za czasy t: i & mogly by¢ prosto obliczone ze wzoru na pole pod wykresem posiadajace
ksztalt trojkata. Wobec tego sprawno$é ukladu znaczaco wzrosta (w stosunku do uktadu o dziataniu
ciagltym) do wartosci

_P-AP. _19W-15W
P 19W

1

=092

Przypomnijmy, ze wynik ten otrzymaliSmy przyjmujac parametry tacznika raczej z dolnej potki
(gorsze osiagi) niz z gérne;j.

Powyzszy przyklad pokazuje, ze uklady przelaczane umozliwiaja przetwarzanie energii z
duzo wieksza sprawnoscia, niz uklady o dzialaniu ciagglym. Jak mozna jednocze$nie stwierdzic, na
sprawno$¢ konkretnego ukladu decydujacy wplyw maja dwa parametry lacznika
polprzewodnikowego:

1) napiecie (czy tez rOwnowaznie rezystancja) w stanie zalgczenia oraz

2) czas przelgczania (narastania i opadania).
2.3.d. Filtracja

Do tej pory nie analizowaliSmy przebiegu napigcia wyjsciowego. Tymczasem, ze wzgledu na
impulsowy przebieg pradu i,, rOwniez napiecie wyjsciowe — jako spadek potencjatu na rezystancji
Ri — uzyskuje przebieg impulsowy. Obecnie zmienia sie ono od 0 V (w takcie 2) do 19 V (w takcie
1).

Zwréémy jednak uwage, ze przy wybranym wspélczynniku wypelnienia D = 0,5, wartosé
$rednia napiecia wyj$ciowego wynosi

0VE‘5us+19VE‘5ps
Moty = 10 us

=95V (2.13)

(przy zaniedbaniu czasdéw przelaczania & i t;, jednak jak mozna zauwazy¢, warto$c $rednia przebiegu
U, za te przedzialy jest identyczna). Jest to bliskie poprzedniej (i pozadanej) U, = 10 V (patrz rys. 3).
Roéznica 0,5V stanowi 5%, a wiec w duzej liczbie aplikacji mozna by ja uzna¢ za dopuszczalna.
Gdyby za$ 5% nie bylo akceptowalne, wystarczy, aby tranzystor byl nieco dluzej zalaczony
(doktadnie przez 5,27 ps), co podniesie $rednig do 10 V. Uklad ze sterowaniem impulsowym jest wiec
rownowazny poprzednim rozwigzaniom pod warunkiem, ze zrealizujemy usrednienie przebiegu
napiecia wyj$ciowego.

Idealne usrednianie oznacza odrzucenie wszelkiej zmiennosci, a wiec catkowitg eliminacje
wszelkich skladowych (w sensie analizy harmonicznej, tj. transformaty Fouriera) o czestotliwosci
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wiekszej od 0. Tym samym z przebiegu pozostaje wylacznie skladowa stala. Usrednianie
nieidealne (rzeczywiste) rozni sie tylko tym, ze zamiast calkowitej eliminacji uzyskujemy sttumienie
ze skonczong silg (nie do zera) oraz czestotliwo$¢ graniczng nie zerows, ale jakas wieksza, ktora
realnie mozna otrzymac.

Powyzsza interpretacja usredniania opisuje nic innego, jak filtr dolnoprzepustowy o pewnym
tlumieniu i czestotliwosci odciecia. Idealng filtracje zrealizowalby filtr o nieskonczenie duzym
thumieniu i nieskonczenie matej czestotliwosci odciecia. Schemat ukladu o dzialaniu przetaczajacym
z uwzglednieniem filtru przedstawiono na rys. 1c. Oznaczenie U, odnosi si¢ nadal do samego wyjscia
przeksztaltnika (zaciskow odbiornika); natomiast dotychczas rozwazane napiecie u, znalazlo sie
wewnatrz ukladu, dlatego nadano mu oznaczenie u,'. Filtr realizuje przemiane napiecia zmiennego
uo" (o ksztalcie identycznym jak u, na rys. 3) w napiecie stale U, rowne wartosci $redniej uo’(av)
przebiegu u,'.

Najprostszym filtrem analogowym jest obwdd RC. Jego wadg jest jednak wystepowanie strat
mocy w oporniku, ktére obnizylyby sprawnos¢ przeksztattnika. Dlatego w najprostszych
przetwornicach stosuje si¢ najprostszy filtr bezstratny (w ideale) — obwoéd LC. Tlumaczy to obecnos¢
kondensatora i dlawika na minimalnej liscie elementéw podanej w paragrafie 2.1.b. Sposob
wlgczenia elementéw filtru w obwdd jest zagadnieniem zlozonym i trudnym do uogélnionej analizy.
Problem ten przeanalizujemy w uproszczeniu juz na konkretnym przyktadzie uktadu badanego w
niniejszym ¢wiczeniu.
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3. Przetwornica pradu statego obnizajaca napiecie

3.1. Topologia i elementy ukfadu

3.1.a. Uktad wyjsciowy

W podrozdziale 2.3 i na rys. 1c zostala przedstawiona idea impulsowego przeksztaltnika energii
pradu stalego, przetwarzajacego pewne napiecie wejsciowe U; na odpowiednio nizsze napiegcie
wyjsciowe U,. Byla to jednak wylacznie idea. Obecnie wyprowadzimy topologie praktycznego
uktadu realizujgcego te funkcje. Wiemy juz, ze do tego celu niezbedny jest sterowalny lacznik
polprzewodnikowy (nieco inny niz rozwazany do tej pory) i filtr LC. Zajmiemy si¢ wylacznie
obwodem mocy; praktyczny uklad sterowania pokazany zostanie w ramach innego ¢wiczenia.

Zacznijmy od narysowania ukladu bez przeksztaltnika. Na razie sktada si¢ on ze Zrédia napigcia
stalego o pewnej warto$ci Ui oraz odbiornika, ktéry obcigza uklad pewnym pradem I, (rys. 4).
Poniewaz brak jest przeksztaltnika, wiec

U, =U, 3.1)

[} 1

I =1 (3.2)

o 1

Obciazenie I, najwygodniej jest opisa¢ poprzez roéwnowazna rezystancje zastepcza
wynikajaca z prawa Ohma:

d

RL = IO (3.3)

o

orp ][]

Zrédto Odbiornik

Rys. 4. Zrédlo i odbiornik rozpatrywanego uktadu przeksztatcania
energii elektrycznej
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Rys. 5. Wyprowadzenie topologii przetwornicy obnizajqcej napigcie: a) z
tgcznikiem; b) z dlawikiem; c) z kondensatorem; d) z fizycznymi
tgcznikami potprzewodnikowymi

Wiekszo$é praktycznych odbiornikéw przetwornic da sie — w uproszczeniu — zaklasyfikowac do
jednej z dwu kategorii:

1) odbiorniki o statej (w funkecji pradu L) rezystancji R, — do ktoérych nalezg np.
elementy grzejne stosowane w lutownicach czy lampy zarowe;

2) odbiorniki o staltym (w funkcji napiecia Us) poborze pradu I, — do ktérych naleza
np. elektroniczne uktady cyfrowe (pamieci, mikroprocesory).

Pomijamy oczywiscie dlugoterminowsa zmienno$¢ w funkcji czasu, ktéra moze wynika¢ z
nagrzewania sie lampy czy zmiany obcigzenia (obliczeniowego) mikroprocesora.
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Wyzej przedstawione dwie opcje to nic innego jak matematyczne modele (czyli opisy)
rzeczywistych odbiornikéw. Sa one o tyle uzyteczne, ze pozwalaja na latwa analize pracy
przeksztaltnikow. W niniejszym ¢wiczeniu oprzemy si¢ na pierwszym z nich - statej rezystancji.
Przypadek ten jest tatwiejszy w analizie, niemniej nalezy sobie zdawac¢ sprawe, ze wigksza czes¢
rzeczywistych aplikacji opisuje model statego pradu.

Analiza niektérych uktadow wymaga¢ moze komplikacji modelu odbiornika. W przypadku
rezystancji moze to oznacza¢ dopuszczenie jej ujemnej wartosci (im mniejsze napiecie, tym wiekszy
prad), za§ w przypadku pradu - przyjecie bardziej ogélnego zalozenia stalej mocy czynnej (iloczynu
pradu i napiecia). Zwiekszenie zlozonosci modelu pocigga za sobg komplikacje réwnan
matematycznych opisujacych obwod. W takim przypadku nieoceniong pomoc dla inzyniera stanowi
symulacja komputerowa.

Mniej problematyczne jest modelowanie Zrodla energii. W wiekszosci przypadkéw, niezaleznie
od jego rzeczywistej realizacji, mozna je przedstawi¢é w postaci Zrodla napiecia stalego -
idealnego lub z uwzglednieniem szeregowej rezystancji wewnetrznej. Rezystancja ta
odzwierciedla wowczas zmniejszenie napiecia wraz ze zwigkszaniem poboru pradu. Tu rowniez w
przypadku konieczno$ci uwzglednienia bardziej zlozonego charakteru zrddla, wykorzystuje sie
symulacje komputerows. My natomiast dla uproszczenia analizy zalozymy, ze zrédlo jest idealne.

3.1.b. Zmniejszenie wartosci sredniej napiecia wyjsciowego

W  paragrafie 2.3.d wykazaliSmy liczbowo, ze zastosowanie przelaczanego 1lacznika
polprzewodnikowego powoduje uzyskanie wartosci $redniej napiecia wyjSciowego uoay) mniejszej
niz napiecie wejsciowe U. Obecnie dokonamy uogélnionej analizy tego ukladu, przy czym dla
uproszczenia zalozymy, ze lacznik jest idealny. Uklad z rys. 4 uzupelniony o taki lacznik S -
wlaczony szeregowo, analogicznie do rys. 1b — przedstawia rys. 5a.

Uproszczony przebieg napiecia wyjsciowego u, w tym ukladzie przedstawiono na rys. 7. Funkcja
S oznacza biezace potozenie tacznika zgodnie z rys. 5a. Napiecie wejsciowe Ui jest oczywiscie stale,
natomiast prad wyjéciowy i, — proporcjonalny do napiecia u, zgodnie z prawem Ohma (3.3).

Jak zauwazyli$my w paragrafie 2.3.b, kazdy okres przelaczania T; mozna podzieli¢ na dwa
takty.

1. Takt 1, kiedy lacznik jest zalaczony (pozycja S = 1), trwa od chwili #; do chwili &,
przez czas DT;. Zalaczony tacznik idealny stanowi zwarcie (rys. 6a), wobec tego
napiecie wyjsciowe wynosi

u, =U, (3.4)

o 1

2. Takt 2, kiedy lacznik jest wylaczony (pozycja S = 0), trwa od chwili > do chwili
13, przez czas (1-D) Ts. Wylaczony tacznik idealny stanowi rozwarcie (rys. 6b),
wobec tego w obwodzie nie plynie prad:

i,=0 (3.5)
stad z prawa Ohma (3.3)
u, =i,R =0 (3.6)
Biorac pod uwage powyzsze, warto$¢ srednia napiecia wyjsciowego z definicji wynosi
)

1 1% 1 1 1(% 1
Hoay =?juodz:?juodzzF(IuodHtjuodz}=F[jUidz+tj0dz}=
2 2

s Ty S n s\ f s\ n
(3.7)
1 % i 1 1
= U [de+0[ dt —E[Ui [t, —t,) +0 [ty —tz)]—F[Ui [DT, = DU,

S S

n 15}
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C)fUi Ug HRL C)fUi Ug |:|R|_

Rys. 6. Zredukowana topologia obwodu z rys. 5a: a) w takcie 1; b) w takcie 2

SA
0 >
L, L, A t
_ DT, + (1-D)T, =
T,
u, A
U
t'
i A
U/R.

Rys. 7. Przebiegi napiec i prqdow w uktadzie z rys. 5a

Ustawiajac odpowiedni wspolczynnik wypelnienia D = 0,5, mozemy wiec uzyska¢ dowolne
Srednie napiecie wyjsciowe uo@yv) z przedzialu 0..U; — a wigc zrealizowaé¢ pozadana funkcje
obnizenia napiecia.

W niektérych aplikacjach dzialanie powyzsze bedzie zupelnie wystarczajace. Dotyczy to
przede wszystkim odbiornikéw, w ktérych usrednienie wielkosci wyjSciowej nastepuje na etapie
konwersji energii elektrycznej na inng postac energii.

Przykladem moze by¢ lampa halogenowa. Wielkoscig wyjsciowa jest w tym przypadku strumien
$wietlny, opisujacy moc emitowanego $wiatla. Rozgrzewanie i chlodzenie zarnika (wldkna) jest
procesem bardzo powolnym. Jezeli lgcznik bedzie przelaczany z odpowiednio wysoka
czestotliwoscia, to — mimo, ze lampa przez czes¢ okresu Ts nie jest zasilana — miedzy kolejnymi
przelaczeniami temperatura zarnika zmieni si¢ nieznacznie. Lampa nie tylko nie zga$nie, ale
tetnienie jej $wiatla bedzie niezauwazalne dla oka ludzkiego (wystarcza do tego czestotliwosé
kilkudziesieciu hercéw, co z punktu widzenia wspolczesnej elektroniki mocy jest wartoécia niska).
Mimo, Ze napiecie u, jest wyraznie zmienne w czasie, wielko$¢ wyjsciowa (strumienn swietlny) jest
prawie stala, proporcjonalna nie do jego wartosci chwilowej u,, ale $redniej uov). Powodem tego
jest mechanizm fizyczny konwersji energii elektrycznej na cieplna w zarniku - procesy
cieplne zachodza duzo wolniej niz elektryczne.

W powyzszym przypadku zadna filtracja napiecia wyjsciowego nie jest konieczna - moze
ono by¢ przebiegiem przerywanym (tj. o zerowej wartosci chwilowej przez czes¢ okresu) bez szkody
dla funkcjonalnosci rozwazanej aplikacji. Uktad dzialajacy na tej zasadzie nazywa si¢ przerywaczem
napiecia stalego (ang. DC voltage chopper, dost. ‘siekacz napigcia statego’).
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3.1.c. Uzyskanie nieprzerwanego przekazu energii za pomoca cewki

Duza cze$é aplikacji nie moze by¢ jednak zasilana w sposob przerywany. Przykladem
moga by¢ przywolane wyzej cyfrowe uklady elektroniczne — jest oczywiste, ze napiecie zasilajace
mikroprocesor czy pamie¢ RAM nie moze co kilka mikrosekund zanikac.

Przewodowa transmisja energii elektrycznej wymaga ruchu fadunkéw w przewodniku, czyli
pradu. Nieprzerwane dostarczanie energii elektrycznej wymaga wiec nieprzerwanego
przeplywu pradu. Aby go uzyskaé, nalezy w obwdd wlaczyé element elektryczny, ktory
zapobiegnie natychmiastowemu spadkowi pradu wyjsciowego i, do zera w chwili &, kiedy to
otwarcie tacznika likwiduje polaczenie elektryczne miedzy zrédlem a odbiornikiem.

Elementem, ktory przeciwstawia si¢ zmianom pradu jest, jak wiadomo, cewka. Jest to
jedna z konsekwencji zasady zachowania energii, moéwiacej, ze zmiana energii ukladu (w tym
wypadku cewki) moze by¢ wylacznie wynikiem dostarczenia dodatkowej energii z zewnatrz. W
przyrodzie Zadna energia nie moze zosta¢ dostarczona w zerowym czasie, gdyz oznaczaloby to
nieskonczona warto$¢ mocy chwilowe;j

dw
=— 3.8
P== (3:8)
a) i L i b) ii=0 L i

Rys. 8. Zredukowana topologia obwodu z rys. 5b: a) w takcie 1; b) w takcie 2

SA
2
1
t t t t
| DT, (1-D)T, ’
TS
u, A
U
] Y
\ \ Au,
A
t
i=i, A
UJR,
. . Y
Lol = / | A,
t'
e Ai
Y

Rys. 9. Przebiegi napigé i prqdow w uktadzie z rys. 5b
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W zwiazku z tym energia zgromadzona w cewce nie moze zmieni¢ si¢ skokowo. Energia ta
gromadzona jest w polu magnetycznym wytwarzanym przez prad; wielkosci te $ciSle wigze
zaleznosé

W, _ Lip (3.9)

gdzie L - indukcyjnos¢ cewki, i — natezenie pradu cewki. Tym samym z zasady zachowania
energii wynika ciaglo$¢ pradu w cewce — nie moze si¢ on zmienia¢ skokowo.

Aby prad nie przestawal nagle ptynaé przez odbiornik w chwili £, cewke trzeba wlaczy¢ tak,
aby plynal przez nia prad odbiornika i,. Wowczas spowolnienie zmian pradu cewki i bedzie
réwnoznaczne ze spowolnieniem zmian pradu i,. Cewka powinna wigec by¢ wlaczona w szereg z
opornikiem Ry, co pokazuje rys. 5b.

Skoro jednak prad ma plynac¢ przez cewke nieprzerwanie, to nalezy wytworzy¢ dlan sciezke na
czas, gdy lacznik nie znajduje sie w pozycji 1 (od chwili ). W tym celu do obwodu zostata
wprowadzona dodatkowa galaz, przez ktorg prad cewki i odbiornika i, powinien ptyngé¢ w takcie 2.
Do przetaczenia pradu dlawika z wejscia na te dodatkowa galaz mozna wykorzysta¢ lqcznik
dwupozycyjny (ang. double-throw switch).

Do tej pory rozwazaliSmy najprostsze laczniki - jednopozycyjne (ang. single-throw switches). Sa
one réwniez zwane lqcznikami zwierno-rozwiernymi, co odnosi sie do ich zdolnosci zwarcia lub
rozwarcia dwoch punktéw obwodu. Istnieja jednak — i sg realizowalne z uzyciem przyrzadow
polprzewodnikowych - rowniez inne typy lacznikow. Miedzy innymi #qczniki przelqgczne
pozwalaja przelqczyc prad bieguna (ang. pole — punkt ,mocowania” ramienia lacznika) do jednej z
dwoch lub wiecej galezi. Taki lacznik moze byé wiec zawsze zalaczony, przy czym jeden z
taczonych punktow (biegun) pozostaje staly, a drugi mozna zmieniac.

W najprostszym przypadku, gdy przelaczanie mozliwe jest miedzy dwoma punktami, méwimy o
faczniku dwupozycyjnym. Taki wlasnie znajduje si¢ w ukladzie z rys. 5b - jego dwie pozycje
oznaczono jako ,1” (jak poprzednio — w takcie 1) i ,2” (w takcie 2). Dzialanie lacznika powoduje
okresowg zmiane topologii ukltadu w sposéb przedstawiony na rys. 8.

3.1.d. Analityczny opis dziatania dtawika

Opiszmy dzialanie cewki matematycznie. W kazdym z dwoch taktéw mamy do czynienia z
szeregowym obwodem RL opisywanym napieciowym prawem Kirchhoffa

E=u; +u, (3.10)
gdzie uy jest napieciem na cewce, za$ E — napieciem wymuszajacym, ktore w takcie 1 wynosi U (rys.

8a) za$ w takcie 2 wynosi 0 (zwarcie, rtOwnowazne zrodhu zerowemu — rys. 8b). Podstawiajac prawo
Ohma (3.3) i rtOwnanie cewki

di
u = d—tL (3.11)

oraz uwzgledniajac, ze w obu taktach i, = i, otrzymujemy réwnanie obwodu RL

di,
dr

Ri +L—-E=0 (3.12)

Stosujac dowolng metode rozwigzywania roéwnan rézniczkowych dochodzi sie do rozwiagzania

i() =i, (t,)+ [ﬁ - io(to)j EEl —e_foj (3.13)
RL
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\ 4
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»
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Rys. 10. Przebieg prqdu wyjsciowego w uktadach z rys. 5: a) brak dlawika
(rys. 5a); b) dlawik (rys. 5b) o matej indukcyjnosci (t < Ts); c¢) dlawik o
duzej indukcyjnosci (t = Ts)

gdzie 7 jest tzw. stalq czasowq (ang. time constant) obwodu RL réwna
T=— (3.14)

chwila # oznacza za$ poczatek danego taktu pracy, a wiec odpowiednio #; lub #. Przeanalizujmy
wyniki zastosowania wzoru (3.13) do kazdego z taktow.

1. Dla taktu 1, & = t;. Zalézmy, ze na poczatku prad jest zerowy: io(ty) = 0. Jak
stwierdziliSmy, w tym takcie w obwodzie obecne jest zZrodlo E = U (rys. 8a).
Rowanie (3.13) w tym przypadku prowadzi do

-1
U, —

i(f)= l-e 7 (3.15)

L

Podstawiajac t = t; i t = 0o, mamy
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L

i1, =%EEl—e_r]z%[(ﬂ—e‘o):ﬂ[m—l)zo (3.16)

(3.17)

Prad zmienia sie wiec wyktadniczo (zaleznos$¢ postaci ef), narastajac od 0 do
U/RvL. Zobrazowano to na rys. 10b przy zalozeniu, ze do konca taktu 1 prad
zdazy sie ustalié, co oznacza, ze io(tz) = io(00).

2. Prad na poczatku taktu 2 (t = t2) jest rowny pradowi na koricu taktu 1, a wiec w
przyblizeniu Uy/Ry. Jak ustalilismy wyzej, E = 0. Z rownania (3.13) uzyskujemy

wiec
I i) )
=2 Yimoer |=Yigogee 7 =Yg (3.18)
RL RL RL RL

Podstawiajac t = t i t = 0o, mamy

iy
io(tz):ﬂ@ r :i@_ozﬂﬂ:ﬂ (319)
Ry Ry Ry Ry,
co zgadza sie z zalozeniem, oraz
U "2 U __, U
ij(0)=—[¢ T =—[7 =—[0=0 (3.20)
Ry, Ry Ry

Prad zmienia sie wiec wyktadniczo, opadajac od Ui/R. do 0. Zobrazowano to na
rys. 10b przy zalozeniu, ze do konca taktu 2 prad zdazy sie ustali¢, co oznacza, ze
io(t3) = io(00).

Czas ustalenia si¢ pradu zalezy od wartosci stalej czasowej 7. Z réwnania przebiegu
wykladniczego mozna obliczy¢, ze prad osigga swojg wartos¢ ustalong z dokladnoscig 1% (0,01) po
czasie rownym 7In(1/0,01) ~ 4,67. Wobec tego z zaleznosci (3.14) wynika, ze im wieksza
indukcyjnos¢ cewki (dla danej rezystancji R.), tym wolniejsze narastanie, czyli tym silniej cewka
przeciwstawia si¢ zmianom pradu. W elektronice mocy cewke o indukcyjnosci na tyle duzej (dla
danego obwodu), Ze wyraznie spowalnia ona zmiany pradu, nazywa sie dlawikiem (ang. choke).

Przy odpowiednio duzej indukcyjnosci dlawika, miedzy kolejnymi przelaczeniami igcznika
prad ani nie zdazy narosnaé¢ do U/R., ani opasé¢ do 0. Sytuacje taka przedstawia rys. 10c, na
ktérym dla uzyskania wyraznego rysunku stala czasowa jest rzedu okresu przelaczania Ts; w
praktyce moze ona by¢ duzo wieksza. Ogoélnie rzecz biorac, warunek wystapienia stanu z rys. 10c
mozna w uproszczeniu sformutowa¢é jako

AT ST, (3.21)
gdzie liczba 4 jest zaokragleniem w doét wartosci 4,6 uzasadnionej wyzej. Stad, podstawiajac (3.14),

R
L>—L (3.22)

4
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Poniewaz prad dlawika ptynie rowniez przez rezystancje odbiornika R, wiec prad i, ma takze
ksztalt zgodny z rys. 10c. Zgodnie z prawem Ohma (3.3), na odbiorniku odklada sie proporcjonalne
do tego pradu napiecie u, — o takim samym ksztalcie, co pokazano na rys. 9.

3.1.e. Zmniejszenie tetnienia napiecia za pomoca kondensatora

Wprowadzajac do obwodu dlawik osiggneliémy wprawdzie cigglos¢ dostarczania energii
do odbiornika, ale nie stalo$¢ napiecia u, na nim. Poziom tetnienia tego napiecia Au, (rys. 9)
moze by¢ dla wielu odbiornikéw nieakceptowalny - na przyklad wskutek blednego dziatania
analogowych i cyfrowych ukladéw scalonych. Zmniejszenie tetnienia napiecia wyjSciowego
wymagaloby takiego samego zmniejszenia tetnienia pradu Air, ktére - jak pokazaliSmy w paragrafie
3.1.d - zalezy (malejaco) od indukcyjnosci dlawika L.

Jak pokazuje praktyka, w wiekszosci aplikacji osiggniecie akceptowalnie malego tetnienia
wymagaloby uzycia dlawikéw o nieakceptowalnie duzych wymiarach, cigzarze, koszcie, stratach
mocy itd. Poza tym dlawik nie pozwala na filtracje zaburzen wysokiej czestotliwosci (krotkich
szpilek i szybkich oscylacji), nierozerwalnie zwigzanych 2z ukladami mocy o dzialaniu
przelaczajacym (zagadnienia tego nie bedziemy jednak analizowaé w niniejszym ¢wiczeniu).

Z powyzszych powodoéw konieczne jest uzycie elementu biernego drugiego typu -
kondensatora. Energia zgromadzona w polu elektrostatycznym kondensatora wyraza sie zaleznoscia

_ Cug
2

W, (3.23)

gdzie C - pojemnos¢ kondensatora, uc — napiecie na kondensatorze. Z zasady zachowania energii
wynika wiec, Ze napiecie na kondensatorze nie moze sie zmienia¢ skokowo.

Aby skorzysta¢ z powyzszej wlasciwoéci w rozpatrywanym ukladzie, nalezy kondensator
wlaczy¢ tak, aby wystepowalo na nim napiecie odbiornika u,. Woéwczas spowolnienie zmian
napiecia na kondensatorze uc bedzie roéwnoznaczne ze spowolnieniem zmian napigcia .
Kondensator powinien wigc by¢ wlaczony rownolegle do odbiornika, co pokazuje rys. 5c.

3.1.f. Analityczny opis dziatania kondensatora

Po wlaczeniu kondensatora, prad dlawika i musi ulec podzialowi na dwie galezie -
kondensatora i odbiornika. Zgodnie z pradowym prawem Kirchhoffa (por. rys. 5c)

i =i+, (3.24)

Sprobujemy teraz przewidzie¢, jak konkretnie wyglada ten podzial. W tym celu konieczne jest
ponowne odwolanie si¢ do rys. 9 i wydzielenie w pradzie dlawika i dwoch skladowych: statej L) i
przemiennej ir(a), przy czym

i, =1y +ig (3.25)

Z analizy harmonicznej (rozwiniecia w szereg Fouriera, zob. instrukcje 0, par. 2.5) wynika, ze
sktadowa stala kazdego przebiegu jest rowna jego wartosci Sredniej, a wigc w naszym przypadku
iL(av) (patrz rys. 9). W konsekwencji skladowa przemienng mozna wyrazi¢ jako

I =i~ D) T Ty (3.26)

Jest to wiec przebieg i przesuniety o swoja warto$é S$rednig w dot (por. rys. 9). Skitadowa
przemienna z definicji nie posiada sktadowej stalej, gdyz powstala przez jej odrzucenie. Wobec tego
jej warto$¢ srednia wynosi 0. Tym samym przebieg iL) ma identyczny ksztalt i amplitude Ai, co
przebieg iL, ale jego tetnienie odbywa sie nie wokot poziomu I, lecz wokot osi czasu.

Modut impedancji idealnego kondensatora wynosi
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|Zo|=—= (3.27)

Dla f— 0 mamy |Zc| — oo, co oznacza, ze dla sktadowej stalej kondensator stanowi rozwarcie; tym
samym skltadowa stala nie moze nigdy ptynaé przez ten element. Z kolei sktadowe pradu o wysokich
czestotliwodciach (jak na przyklad czestotliwos¢ przelaczania przetwornicy f;) beda z tatwoscia
przeplywaly przez kondensator, gdyz dla f— co mamy |Zc| — 0.

Ze wzoru (3.27) wynika, ze impedancja kondensatora dla danej czestotliwosci f jest tym
mniejsza, im wieksza pojemno$¢ C. Kondensator C i odbiornik Ry stanowig dzielnik pradowy,
ktorego dzialanie dla okreslonej czestotliwosci opisuja wzory

_ Ry — 1_
ST, FY RN AT;
RL
(3.28)
I =] M =] ;
o(f) L(f)|ZC(f)|+RL L(f)1+| RL |
Zc(f)

gdzie Iy oznacza warto$¢ skuteczna pradu sinusoidalnego o czestotliwosci f. Powyzsze zaleznosci
mozna odczytac nastepujaco:

* im mniejsza impedancja kondensatora dla danej czestotliwosci fwzgledem
rezystancji odbiornika, tym wieksza czes¢ pradu o tej czestotliwosci Ic(
poplynie przez kondensator (mianownik we wzorze na Ic(j) maleje, wiec catos¢
rosnie);

= za$ tym mniejsza cze$¢ Iy poplynie przez odbiornik (mianownik we wzorze na
Iy rosnie, wiec calos¢ maleje).

Zwroémy uwage, ze w rozpatrywanym ukladzie zalezy nam na tym, aby z przebiegu i, pozby¢
sie skladowej przemiennej. Wowczas prad odbiornika i, bedzie pradem stalym, a w konsekwencji —
zgodnie z prawem Ohma (3.3) - napiecie na odbiorniku u, bedzie rowniez stale. Bylby to oczywiscie
przypadek idealny; w rzeczywistosci skladowej przemiennej nie da si¢ catkowicie wyeliminowac,
jednak mozna jg znaczaco zmniejszy¢ w stosunku do ukladu z rys. 5b.

Jak zauwazylismy, skladowa stala pradu dtawika nie moze ptyna¢ przez kondensator, w zwigzku
z tym w calosci trafia do odbiornika:

few =0 (3.29)
Loy =110

Wynik ten mozna réwniez uzyska¢ podstawiajac (3.27) wraz z f= 0 do (3.28). W jaki sposéb mozna
przekierowa¢ cala skladowsg przemienng do kondensatora? Z zaleznosci (3.28) wynika, ze
warunkiem tego jest

Z
|Ze () <<R, < | ‘;;M <<1 (3.30)
L
gdyz wowczas
_ 1 _ 1 _
Ieg) = IL(f)—|ZC(f)| = IL(f)I =1y (3.31)
1+
RL

Impedancja kondensatora Zc jest jednak funkcjg czestotliwoéci. Skladowa przemienna pradu
dlawika i, ma ksztalt w przyblizeniu trojkatny (patrz rys. 9). Jak wykazuje analiza Fouriera,
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przebieg tréjkatny mozna przedstawi¢ jako sume przebiegéw sinusoidalnych o czestotliwosci f; i jej
nieparzystych wielokrotnosciach. Jezeli wiec warunek (3.30) bedzie spelniony dla czestotliwosci f;, to
bedzie on takze speliony dla calej skladowej przemiennej pradu dlawika. Bowiem pozostale
sktadniki maja wyzsze czestotliwosci (3f;, 5fs itd.), za$ | Zc| spada z czestotliwoscia. Tym samym cala
sktadowa przemienna pradu dlawika i poplynie przez kondensator. Podstawiajac (3.27),
uzyskujemy warunek (3.30) w postaci

1
2nf R,

C>> (3.32)

Podsumujmy:

1° skladowa stata pradu dlawika nigdy nie moze ptynac przez kondensator, wobec
tego plynie ona w calosci przez odbiornik:

I, =0
o (3.33)
IO(O) - IL(O)

2° jezeli pojemnos¢ kondensatora jest odpowiednio duza - spelnia warunek (3.32) -
to skladowa przemienna pradu dtawika praktycznie w calosci poptynie przez
kondensator, a wiec nie przez odbiornik:

o =i
cw (3.34)
Iy = 0

Ostatecznie

ic =1l i =i (3.35)
Iy = Loy Figw = L1

Uzyskujemy tym samym nie tylko ciagly (nieprzerwany) przepltyw pradu przez odbiornik, ale
rowniez (w przyblizeniu) stala (niezmienng) wartos¢ tego pradu.
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3.2. Dziatanie ukfadu przetwornicy obnizajacej

3.2.a. Napiecie wyjsciowe w uktadzie z kondensatorem

Zalézmy, ze kondensator w ukladzie z rys. 5c ma odpowiednio duza pojemnos¢, spelniajaca
nierdwnosc (3.32). Woéweczas, zgodnie z prawem Ohma (3.3), napiecie wyjsciowe mozna uznaé za
stale, rowne

u, =i, Ry =1l oR =U (3.36)

[}

Wobec powyzszego, w obu taktach na dlawiku wymuszane jest stale napiecie o wartosciach
wynikajacych z napieciowego prawa Kirchhoffa (patrz rys. 111 12):

1) w takcie 1

u, =U,-U (3.37)

u, =-U (3.38)

Odwolajmy sie teraz do definicji stanu ustalonego przeksztattnika (stanow przejsciowych nie
rozwazamy - jest to duzo bardziej zlozone i wymaga skomplikowanego opisu matematycznego).
Moéwi ona miedzy innymi, ze energia zgromadzona w elementach biernych ukladu nie moze
si¢ zmienia¢ w kolejnych okresach, tj. musi by¢ taka sama na poczatku kazdego kolejnego
okresu T;. Dla dlawika oznacza to

W, (1) =W, (1 +T) (3:39)

Dla ustalenia uwagi rozpatrzmy dotychczas rozwazany konkretny okres pracy zaczynajacy sie¢ w
chwili #; oraz skorzystajmy z zaleznosci (3.9). Dostajemy

WL(@) =W (5) (3.40)
Lig (1) _ Lii(1;) (3.41)
2 2 '

i () =i (13) (3:42)

Uzyskany wynik oznacza, ze na koniec taktu 2 prad musi wroci¢ do wartosci, ktéra mial na
poczatku taktu 1. Tym samym, w ciggu taktu 2 musi opasc¢ o taka sama wartos¢ Air, o jaka wzrost
w ciggu taktu 2:

(A1), = =(At), (3.43)

Zmiany pradu mozna uzalezni¢ od wystepujacych w ukladzie napie¢ korzystajagc z réwnania
cewki (3.11). Zapiszmy je dla kazdego z taktow:

di
U, = L(d_tLj (3.44)
1
di
U, = L(d_tLj (3.45)
2
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b) ii=0 L iL lo=IL(0)

——
u
IC=IL(av)

Rys. 11. Zredukowana topologia obwodu z rys. 5¢c:  a) w takcie 1; b) w takcie 2

SA
2
1
t t t t
| DT, | (1-D)T, !
< Ts »
u, A
U
UO
t'
u A
U-U,
—U, t
iL=io A
UIR,
PN TLLTELTEPTETTICLLY e . "
1=l 0=ie) 1= —i——== e e ————— | A
t'
S TL A
Y
........... T S ST S ‘
A
Rys. 12. Przebiegi napiec i prqdow w ukfadzie z rys. 5c
i podstawmy zaleznosci (3.37) i (3.38):
dip ) _U-U, (3.46)
dr ), L
dip) _-U, (3.47)
dr ), L

Zauwazmy, ze prawe strony obu rownan sa wartosciami statymi, stad i lewe strony musza by¢ state.
Lewe strony okreslaja za§ pochodnag po czasie, czyli nachylenie przebiegu pradu dlawika.
Wnioskujemy wiec, ze narastanie pragdu dlawika w takcie 1 i jego opadanie w takcie 2
odbywa sie¢ po liniach prostych. Uwzgledniono to na rys. 12 [zwré¢my uwage, ze uzyskane
wyrazenie (3.47) na pochodna w takcie 2 daje warto$¢ ujemna, co oznacza opadanie pradu, czyli w
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pelni zgadza sie z wynikami dotychczasowej analizy]. Dla funkcji liniowej pochodna jest réwna
ilorazowi przyrostu pradu i przyrostu czasu. Stad

(dij _ it i) _ (Ad), (3.48)
e ), -1 DT,
(di j _ i) -it) . (AD, (3.49)
dt ), -t (1-D)I,
skad
(A, = % (3.50)
(A, = Y) 1 - D)T, (3.51)
L
Korzystajac z rownosci (3.43), przyrownujemy prawe strony, otrzymujac
W, -U,)D=U, Q-D) (352)

Przeksztalcajac powyzsze réwnanie, otrzymujemy ostatecznie poszukiwane wyrazenie na
napiecie wyjsciowe uzyskiwane w ukladzie z lacznikiem dwupozycyjnym, dlawikiem i
kondensatorem:

U, =DU, (3.53)

3.2.b. Charakterystyka przetwarzania napiecia

Rownanie (3.53) wyraza statyczng charakterystyke przejsciowq lub charakterystyke
przetwarzania. Jest to najwazniejsza zalezno$¢ opisujaca dzialanie kazdej przetwornicy pradu
stalego. Okresla ona, w jaki sposob wielkos¢ wyjsciowa (napigcie wyjsciowe Us) zalezy od wielkosci
wejSciowej energetycznej (napiecie wejsciowe U) i od wielkoSci wejsciowej sterujacej
(wspolczynnik wypelnienia D).

Poniewaz 0 < D < 1, uklad z rys. 5c realizuje funkcje obnizania napiecia wejsciowego U; w
stopniu zaleznym od wspdélczynnika wypelnienia D. Zauwazmy, ze wynik ten jest zbiezny z
(2.13) [s. 16]: dla zalozonych tam warunkéw pracy Ui=20V i D=0,5, otrzymujemy U, =10 V.
Roéznica 0,5 V wynika z faktu, ze obecnie zaniedbaliSmy spadek potencjalu na tranzystorze, podczas
gdy w podrozdziale 2.3 zatozyliSmy, ze wynosi on az 1 V.

Wynik (3.53) jest tez identyczny z zaleznoscig (3.7). Tym samym wigczone w uklad dlawik i
kondensator spelnily role dolnoprzepustowego filtru napiecia wyjsciowego (por. rys. 5¢ z rys.
1c). Wyeliminowatl on skltadowa przemienna, a przepuscil sktadowa stala, ktora faktycznie rowna
jest wartosci Sredniej napiecia przed filtracja. Wlaczenie dlawika wymagalo jednak zapewnienia
$ciezki dla nieprzerwanego przeplywu pradu, w wyniku czego w ukladzie pojawita sie
dodatkowa galgz, a tacznik zmienit typ na dwupozycyjny.

Wida¢ wiec, ze - tak jak przewidzieliSmy w par. 2.3.d - dodanie filtru pozwala praktycznie
wykorzysta¢ wniesiong przez lacznik mozliwo$é obnizenia napiecia w aplikacjach
wymagajacych zasilania napieciem stalym. Z samym lacznikiem (par. 2.3.d i 3.1.b) mozliwos¢ ta
byla jedynie potencjalna, gdyz napiecie wyjsciowe nie bylo stale, co wykluczalo uzyteczne
zastosowanie tamtego ukladu do wiekszosci odbiornikéw. Stosujac lgcznik i filtr uzyskalismy
napiecie wyjsciowe jednoczesnie obnizone i stale w czasie.

W celu pokazania zaleznoséci wylacznie od wielkosci sterujacej, a wyeliminowania wplywu
napiecia wejsciowego, definiuje si¢ rowniez wspélczynnik przetwarzania napiecia jako

AUO
_U'

1

K, (3.54)
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Podstawiajac (3.53) otrzymujemy, ze dla idealnej przetwornicy obnizajacej napiecie wynosi on

DU.
Kyia = U -=D (3.55)

1

Charakterystyke opisang tg zaleznoscig zobrazowano na rys. 13.

0,8

0,6

0,4

0,2

0 0,2 0,4 0,6 0,8 1
D

Rys. 13. Charakterystyka wspélczynnika przetwarzania napiecia idealnej
przetwornicy obnizajqcej

3.2.c. Pétprzewodnikowy tacznik dwupozycyjny

Z powyzszej analizy wynika, ze uklad z rys. 5c, przy poprawnym doborze wartosci elementow,
realizuje pozadang funkcje. Zawiera on jednak nadal jeden element abstrakcyjny - lacznik.
Praktyczny uklad przetwornicy obnizajacej napiecie - z rzeczywistymi przyrzadami
polprzewodnikowymi - przedstawia rys. 5d. Jak widaé, lacznikowi abstrakcyjnemu z rys. 5¢
odpowiadaja dwa przyrzady polprzewodnikowe: tranzystor i dioda. Pojedynczy przyrzad
posiada bowiem zawsze tylko 2 koncowki glowne, nie mozna wiec za jego pomoca zrealizowac
acznika dwupozycyjnego, posiadajacego 3 koncoéwki.

Sterowanie takim lgcznikiem dokonuje sie oczywiscie za posrednictwem tranzystora, dioda jest
bowiem elementem niesterowalnym. Konstrukcja ukltadu powoduje jednak, ze tylko jeden z dwoch
przyrzadow jest w danym momencie zalaczony. Wynika to z nastepujacego rozumowania.

1. W takcie 1 tranzystor jest zalaczony. Z rys. 5d wynika, ze napiecie na diodzie
mozna wyrazi¢ jako

up =-U, +u; (3.56)

Poniewaz napigcie ur na zalaczonym tranzystorze jest niewielkie, wigc dioda jest
spolaryzowana napieciem ujemnym i nie przewodzi.

2. Na granicy taktow 1 i 2, wskutek zmniejszenia napiecia sterujacego ucs,
zwieksza sie rezystancja dren-Zrédlo tranzystora. Jednakze prad drenu jest
pradem dlawika, ktéry — zgodnie z analizg przeprowadzong w paragrafie 3.1.c —
nie moze nagle przesta¢ plyna¢. Rosnie wigc spadek potencjatu na tranzystorze
ur (skoro rosnie rezystancja przy prawie niezmienionym pradzie). W chwili, w
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ktorej napiecie ur stanie sie wyzsze od napiecia Ui o napiecie progowe diody
Ur(ro):

ur >U; +Ugqg, (3.57)

zgodnie ze wzorem (3.56) napiecie up staje si¢ wyzsze od tego napiecia
progowego. Dioda przechodzi wiec w stan przewodzenia. Tranzystor za$
uzyskuje ostatecznie bardzo wysoka rezystancje. Tym samym nastepuje
przelaczenie lacznika z pozycji 1 w pozycje 2 (por. ze sobg rys. 5¢, d i 11).

3. W takcie 2 dioda stale przewodzi, gdyz stan ten wymusza dlawik dziatajacy jak
zrédio pradowe.

4. Na granicy taktow 2 i 1, wskutek wzrostu napiecia ucs powyzej wartosci
progowej tranzystora Ugs(n), przez tranzystor zaczyna ptynac prad (zgodnie z
jego charakterystyka wyjsciowa). Z pradowego prawa Kirchhoffa wynika, ze
suma pradéw w wezle nie moze sie zmienié, za$ prad dlawika nie moze sie nagle
zmieni¢. W zwigzku z tym tranzystor przejmuje prad dlawika od diody. W
momencie, w ktérym ir = i, prad diody spada do zera, a wigc dioda przechodzi
w stan wylaczenia. Nastepuje przelaczenie tacznika z pozycji 2 w pozycje 1.

Tym samym tranzystor i dioda realizuja funkcje lacznika dwupozycyjnego.

Przelaczanie tranzystora MOSFET realizowane jest poprzez wymuszenie napigcia bramka-zrodto
ucs o odpowiednim przebiegu. Z zasady dzialania tego przyrzadu wynika, Zze musi to by¢ przebieg
impulsowy. Z przeprowadzonego wyzej rozumowania wynika, ze aby zrealizowac¢ funkcje tacznika S
przedstawiona na rys. 12, tranzystor nalezy zalaczy¢ na takt 1, a wylaczy¢ na takt 2. Wobec tego,
biorac pod uwage zasade dzialania tranzystora MOSFET typu N, nalezy wygenerowac napiecie ucs o
przebiegu pokazanym w uproszczeniu na rys. 14. Jest to oczywiscie zadanie osobnego ukladu
sterowania, nie pokazanego na rys. 5d.

Lacznik w postaci tranzystora i diody nie jest jedynym stosowanym rozwigzaniem. Istnieja
rowniez konstrukcje z dwoma tranzystorami. Woéwczas przelaczanie pradu miedzy dwoma
przyrzadami nie zachodzi w sposéb samoczynny przedstawiony wyzej. Uklad sterowania musi wiec
zapewni¢ odpowiedniag synchronizacje przebiegdw sterujacych oboma tranzystorami tak, aby w
kazdej chwili jeden i tylko jeden z nich byl zalagczony - stad okreSlenie przetwornica
synchroniczna (ang. synchronous converter).

uGS“
UGS(on) r—
t t t t
DT, ©  (-DT, i
T,
SA
2

»
>

t

Rys. 14. Uproszczony przebieg napiecia ugs (rys. 5d) niezbedny dla uzyskania funkcji
tgcznika S jak na rys. 12

3.2.d. Prad wejsciowy

W analizie energetycznej przetwornicy, do wyznaczenia mocy wejSciowe], potrzebna bedzie
znajomos¢ skltadowej stalej pradu wejsciowego ii. Jest on rowny pradowi dlawika iL w takcie 1 oraz 0
w takcie 2 (por. rys. 11), skad, z definicji wartosci $redniej,
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Li) =iy =L Mdt:i [ipde+ detJ:TL [i dr (3.58)

Tg DT s DT (1-D)T; s DT

Dokonajmy przeksztalcenia matematycznego uzyskanego wyniku:

1 ..
L, =DE-ID—T [i dt (3.59)

s DT

Wyrazenie po znaku mnozenia z definicji stanowi warto$¢ $rednia pradu dlawika i za przedzial
czasu DT, tj. zalaczenia tranzystora. Prad ten ma ksztalt trojkatny (por. ponownie rys. 11), czyli
sktada sie z dwoch odcinkéw liniowego narastania lub opadania. Nietrudno wykazaé (zaréwno przez
proste rozumowanie, jak i formalnie drogg catkowania), iz warto$¢ $rednia takiego przebiegu jest
réwna po prostu sredniej z wartosci szczytu i wartosci siodla i odnosi si¢ zaréwno do calego okresu,
jak i do kazdego z odcinkéw z osobna. A wiec $rednig za przedzial DT mozna zastgpié wartoScig
$rednig za caly okres i (v), czyli sktadows stalg I o):

Ly, = DUy, = DI\, (3.60)
Korzystajac z (3.35), otrzymujemy ostatecznie:
Loy =DI, =K,I, (3.61)
gdzie przez Kroznaczono stosunek skltadowej stalej pradu wejsciowego do pradu wyjsciowego:

o) _
I

K, = (3.62)

o

Tak wiec w przetwornicy obnizajacej prad wejsciowy jest mniejszy od pradu wyjsciowego
(obcigzenia) w takim samym stosunku, w jakim napiecie wyj$ciowe jest mniejsze od
napiecia wejsciowego [por. zalezno$¢ (3.53)]. Biorac pod uwage (3.53), (3.61) mozna przeksztalcié
do postaci uzaleznionej od napiecia wejsciowego:

I = pYo-p2 Ui (3.63)
Ry Ry

Uzyskane wyrazenie teoretyczne bedzie przydatne podczas wykonywania ¢wiczenia dla oceny,
czy uklad nie pobiera zbyt duzego pradu, co wskazywaloby na blad lub awarie. Potrzebna wowczas
bedzie znajomos¢ teoretycznego pradu wejsciowego takze w ukladzie, od ktorego rozpoczeliSmy
rozwazania — bez elementow biernych (par. 3.1.b). W tym przypadku prad wejsciowy i jest rowny
pradowi wyjsciowemu i, w takcie 1 oraz 0 w takcie 2 (por. rys. 6 i 7). A wiec jego sktadowa stala
wynosi

ho =i = ;,-idﬁi[g fide+ ;omjzitﬁ ; ﬂdﬁo}ig&m; -pYi sy
Lor, T, \on  a-Dy, s \or Ry I, Ry R,
Poréwnanie tego wyniku z (3.63) prowadzi do obserwacji, iz dla D < 1 sktadowa stala pradu
wejsciowego jest wieksza w ukladzie bez filtru. Mozna tatwo wykazaé, ze wynika to z faktu, ze moc
czynna wyjsciowa w obu tych ukladach jest takze rézna — mimo takiej samej wartosci $redniej
napiecia wyjsciowego. W zaleznosci od przebiegu — impulsowego bez filtru, statego z filtrem -
napiecie to ma bowiem rézna warto$¢ skuteczna, a to od niej (przy obciazeniu rezystancyjnym)

zalezy moc czynna.
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3.3.  Wplyw tranzystora na wilasciwosci uktadu

3.3.a. Moc strat w tranzystorze

Sprobujmy okresli¢, w jaki sposob stratno$¢ rzeczywistego lacznika poélprzewodnikowego
wplywa na dzialanie przetwornicy. Dla uproszczenia analizy, ograniczymy sie wylacznie do
rozwazanego w niniejszym ¢wiczeniu tranzystora MOSFET, aczkolwiek analogiczne rozumowanie
mozna przeprowadzi¢ takze dla diody. Do wykonania tego zadania konieczne jest oszacowanie mocy
strat w tranzystorze — zarowno statycznych, jak i dynamicznych.

Aby uprosci¢ obliczenia zalozymy, ze indukcyjnos¢ L jest na tyle duza, ze amplituda tetnienia
pradu jest duzo mniejsza od jego skltadowej stalej

Aip <<Iy, (3.65)
Wobec tego mozna przyjac, ze
i, = L) Y =1y (3.66)

Prad tranzystora (obwodu mocy) w stanie zalaczenia Ipon) rowny jest pradowi dlawika (por. rys.
5d i 11a), a wiec takze moze by¢ uznany za staly. Moc czynna strat statycznych w tranzystorze w
stanie zalgczenia wyraza sie wiec wzorem (patrz instrukcja 34, par. 3.2)

— 2 — 2
PT,slal - DID(on) RDS(on) - DIL(O) RDS(on) (367)

gdzie Rps(on) jest rezystancjg dren-zrédto w stanie zataczenia.

Moc strat dynamicznych mozna oszacowac jak w paragrafie 2.3.c. Nalezy jednak wzia¢ pod
uwage inny charakter przelaczania. Wowczas zatozyliSmy bowiem, ze prad gléwny i napiecie
glowne zmieniajg sie jednoczesnie.

Tymczasem w rzeczywistej przetwornicy obnizajacej — co stwierdziliSmy w paragrafie 3.1.c —
prad dlawika nigdy nie moze przesta¢ pltynaé, z tym ze plynie on albo przez tranzystor, albo przez
diode. Wymuszajac przeptyw pradu, dlawik stanowi wiec Zrodlo pradowe i taki tez charakter
ma obciazenie tranzystora (patrz instrukcja 34, par. 3.3). Przebiegi napiecia i pradu tranzystora
majg charakter typowy dla obcigzenia pradowego, co przedstawiono na rys. 15. Mozna to wyjasnié
nastepujaco.

1. Zgodnie z analizg dzialania lacznika tranzystor-dioda przeprowadzong w
paragrafie 3.2.c, podczas wylaczania tranzystora, napigcie na nim najpierw
rosnie, do chwili, w ktoérej dochodzi do zalaczenia diody. Dopiero wowczas prad
tranzystora moze zanikna¢, gdyz prad dlawika zostaje przejety przez diode.

2. Podczas zalgczania tranzystora, dopoki dioda nie przestanie przewodzi¢ pradu,
napiecie na tranzystorze ur wynosi w przyblizeniu U, gdyz (por. rys. 5d)

up =U, +up, (3.68)

a napiecie na przewodzacej diodzie jest niewielkie. Dopiero kiedy caly prad
dlawika zostanie przejety przez tranzystor, dioda wylaczy sie i przestanie
zwiera¢ zrodlo tranzystora do ujemnego bieguna zrodta napiecia Ui. Napiecie na
tranzystorze bedzie wiec moglo opas¢ do niskiej wartosci Upn.

Dla obciazenia o charakterze zrodta pradowego, moc czynna strat dynamicznych w tranzystorze
wyraza sie zaleznoscig

PT,dyn = % ID(on)UDS(oft) (ton + toff )fs = % IL(O) Ui (ton + toff )fs (369)
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c
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Rys. 15. Uproszczone przebiegi napigcia,
pradu i mocy chwilowej tranzystora w
przetwornicy obnizajqcej

gdzie ton 1 toff 0Znaczaja — bez wnikania w szczegoély — czasy trwania procesu zalaczania i wylaczania
zgodnie z rys. 15. Wobec tego catkowita moc czynna strat

P =P

- nr2
T,stat + PT,dyn - DIL(O) RDS(on) +%IL(0) Ui (ton + toff )fs (370)
Uzyskana zalezno$¢ potwierdza wniosek sformulowany juz w paragrafie 2.3.c: na moc strat
wplyw ma rezystancja w stanie zalaczenia oraz czasy przelaczania. Jak wida¢, moc strat
statycznych rosnie ze wzrostem wspolczynnika wypelnienia; z kolei moc strat dynamicznych
jest tym wieksza, im wieksza czestotliwos¢ przelaczania.

3.3.b. Wplyw strat statycznych na sprawnos¢

Wyprowadzenie analitycznego wyrazenia na sprawno$¢ przetwornicy byloby skomplikowane.
Mozemy jednak przynajmniej stwierdzi¢, jaki wplyw na te sprawno$é ma badany w niniejszym
¢wiczeniu tranzystor MOSFET. Aby zmniejszy¢ liczbe niezbednych zalozen co do wartosci
parametroéw tego przyrzadu, rozwazymy najpierw statyczne straty mocy.

Moc czynna wej$ciowa przetwornicy wynosi

I

) (3.71)

i

1 1
Pi =— juiiidf = Ui_ Iiidt = Uiii(aV) =U
I 1, T

s I

czyli jest rowna iloczynowi stalego napiecia wejsciowego i sktadowej stalej pradu wejsciowego. Ta
ostatnia wyraza sie wzorem (3.60), wobec czego ostatecznie

R = DUiIL(o) (3.72)
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Przyjmujac, Ze zmniejszenie przekazywanej mocy, jakie nastepuje pomiedzy wejSciem a
wyjSciem przetwornicy, wynika wylgcznie ze strat statycznych w tranzystorze, oraz wykorzystujac
wyprowadzone zaleznosci (3.67) i (3.72), uzyskujemy, ze sprawnos$¢ uktadu wynosi

_P _ F _PT,slal _ PT,stat _ IL(O)
/7_?1_ P =1- P =1- U. Rpson) (3.73)

1 1

Stosujac przyblizenie (3.35) i prawo Ohma (3.3), otrzymujemy

R
1- ﬂ DS(on)

3.74
U R (3.74)

3.3.c. Wplyw strat statycznych na wspétczynnik przetwarzania napiecia

Uzyskanie wiecej mowiacej postaci wzoru (3.74) wymaga wyznaczenia zalezno$ci miedzy
napieciem wyjsciowym a wejsciowym. Nie mozemy postugiwac si¢ nadal zaleznoscia (3.53), gdyz
zostala ona wyprowadzona przy zalozeniu, ze zalaczony tranzystor stanowi zwarcie. Tymczasem
wyrazenie (3.74) uzyskali$my uwzgledniajac niezerowg rezystancje zalaczonego tranzystora.

Obecnie napiecie na dlawiku w takcie 1 musimy wyrazi¢ jako (por. rys. 5d)

u =U, ~U, ~uy =U; U, ~Urpy =U; —U, = I Rpsion) =

R 3.75
=U;-U, _ﬁRDs«m) =U, ~U,[1+—22 79
RL RL

Wz6r na przyrost pradu dlawika w takcie 1 (3.50) przyjmie wiec nowa postaé

R
U, =U,| 1+ 1 DT,
RL

(AD), = i (3.76)
z ktorej, przez przyréwnanie do (3.51), uzyskujemy
R
U -U|1+222 D=y, (1-D) (3.77)
RL
1 ostatecznie
U, =U, —2 (3.78)
1+D DS(on)
L
K, = + (3.79)
1+D DS(on)
L

Otrzymany wynik méwi, ze w rzeczywistej przetwornicy napiecie wyjsciowe zalezy od
stosunku rezystancji tranzystora (w stanie zalgczenia) do rezystancji odbiornika. Dla
Rpson) = 0 uzyskujemy oczywiscie zaleznos$¢ (3.53). Natomiast w miare zwiekszania Rpson), przy
stalej rezystancji R, napiecie wyjsciowe staje sie coraz mniejsze.

Rozbiezno$¢ miedzy przetwornicg rzeczywista a idealng zwieksza si¢ rowniez ze wzrostem
wspolczynnika wypelnienia D. Dla D = 0 otrzymujemy wynik U, = 0 jak dla przetwornicy idealne;j.
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Jest to wynik spodziewany, gdyz tranzystor jest wowczas stale wylaczony. Jego stan zalgczenia nie
moze wiec mie¢ zadnego wplywu na dzialanie przetwornicy.

L0 e e—— 1
P
// P
10 -~ 0,6
S /,/ P
= L T . <
7
1 7 /I 04
/ e
/ e i
o / , /| 0,2
o ~
| / il
0,01 I 0
0 0.2 0,4 0,6 0,8 1
D

Rys. 16. Zaleznos¢ mocy czynnych w uktadzie (linie ciggle) i sprawnosci
uktadu n (linia kropkowa) od wspétczynnika wypetnienia impulsow D
(uwzgledniono wylgcznie moc strat statycznych w tranzystorze), dla
parametrow uktadu: Ui = 10 V, Ry = 1 £, Rpsion) = 0,1

3.3.d. Charakterystyki przetwornicy z uwzglednieniem strat statycznych

Podstawiajac (3.78) do (3.74) uzyskujemy zaleznosé¢

R
b oS = - ! = ! (3.80)

RDS(on) RL 1+l RL RDS(on)
D RDS(on)

n=1-

1+D
L

Na rys. 16 przedstawiono zaleznos¢ (3.80) dla przykladowego stosunku Rps(n)/RL = 0,1. Jest to
warto$¢ bardzo duza, wybrana w celu uwypuklenia zachodzacego zmniejszenia sprawnosci. W
rzeczywistosci tranzystor o rezystancji 10 razy mniejszej od rezystancji odbiornika uznaliby$my za
zle dobrany do danej aplikacji. Jak jednak wida¢, nawet przy tak duzym stosunku rezystancji
sprawnos$¢ spada zaledwie do ok. 0,9 dla D = 1.

Tym samym przetwornica obniZajaca napiecie nie jest specjalnie wymagajaca w odniesieniu do
parametrow tranzystora. Nawet z kiepsko dobranym tranzystorem uzyskamy sprawnosé
przetwarzania energii duzo wigksza niz w przypadku ukladéw o dzialaniu ciaglym (por. paragraf
2.2). Przetwornica obnizajaca charakteryzuje si¢ wiec wysoka sprawnoscia w calym
zakresie sterowania (wspolczynnika wypelnienia). Wyrdznia to uklad obnizajacy sposrod
przetwornic pradu statego.

Jak wynika ze wzoru (3.80), dla Rpsen — 0 oraz dla D — 0, sprawno$¢ dazy do jednosci.
Natomiast w miare zwigkszania wspolczynnika wypelnienia, sprawnos¢ spada. Spadek ten jest
tym silniejszy, im wigkszy stosunek rezystancji tranzystora do rezystancji odbiornika.
Potwierdza to rys. 17a, na ktorym wykreslono charakterystyki sprawnosci dla réznych wartosci
stosunku Rps(on)/RL.
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Na rys. 17b przedstawiono z kolei charakterystyke przetwarzania napiecia (3.79). Rowniez ona
dowodzi, ze w przypadku przetwornicy obnizajacej wyrazne odstepstwo od charakterystyki idealnej
obserwujemy dopiero przy wyjatkowo zle dobranym tranzystorze.

a) 1 _ 0
s e 0,001
0.0t
0,98
0,96 \\
< \\
3,1\\
0,94 AN
\\
0,92 \\\
0,9
0 0,2 04 0,6 0,8 1
D
b) 1
0,5”0,01
0,8 //
///o,
0,6 i
; 7
N //
0,4 /
0,2
0
0 0,2 0,4 0,6 0,8 1

D
Rys. 17. Charakterystyki w funkcji wspotczynnika wypetnienia impulsow
D oraz stosunku RpsonyRL (uwzgledniono wylgcznie moc strat
statycznych w tranzystorze; wartos¢ 0 i linia kropkowa opowiada
przetwornicy idealnej): a) sprawnosé; b) wspolczynnik przetwarzania
napiecia

3.3.e. Wplyw strat dynamicznych

Przeanalizujmy z kolei, w jaki sposoéb na dzialanie przetwornicy wptywaja dynamiczne straty
mocy w tranzystorze. Aby zmniejszy¢ liczbe niezbednych zalozen co do warto$ci parametréw,
przyjmijmy tym razem, ze czasy zalaczania i wylgczania sa sobie réwne i oznaczmy ich wspdlng
wartos¢ przez tsw. Wowczas zaleznos¢ (3.69) mozna zapisac jako
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PT,dyn = IL(O)Uitsw s (381)
Korzystajac z zaleznosci (3.72), uzyskujemy wyrazenie na sprawnosc
P, _ B —Pry, Pr gyn t 1t
n=-°= L P RS L0 S D (3.82)

i I I D D T

Powyzsza zalezno$¢ wykreslono na rys. 18 dla réznych wartosci stosunku czasu przelaczania
tranzystora tsw do okresu przelaczania przetwornicy Ts. Zaréwno uzyskana zalezno$é, jak i wykres
pokazuja, ze straty dynamiczne w tranzystorze maja inny wplyw na sprawnos$é niz straty
statyczne w tym elemencie. Wraz ze zmniejszaniem wspolczynnika wypelnienia, sprawnos¢
rowniez spada. Spadek ten jest tym wiekszy, im wiekszy czas przelaczania tranzystora w
stosunku do okresu przelaczania przetwornicy. Przykladowo, stosunek 0,001 odpowiada
tsw = 100 ns przy fs = 10 kHz, lub tsw = 10 ns przy f; = 100 kHz.

pa—. —
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0,001 —
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Rys. 18. Charakterystyki sprawnosci w funkcji wspétczynnika
wypetnienia impulséw D oraz stosunku tsw/Ts (uwzgledniono wylqcznie
moc strat dynamicznych w tranzystorze; wartos¢ 0 i linia kropkowa
opowiada przetwornicy idealnej)

3.3.f. Czestotliwos¢ przetaczania i zastosowanie tranzystorow MOSFET

W rzeczywistym ukladzie réwniez z dioda i elementami biernymi (dlawikiem i
kondensatorem) s zwiazane straty mocy. Powodujg one dalszy spadek sprawnosci i
wspolczynnika przetwarzania napiecia — zaréwno dla duzych, jak i dla malych wartosci
wspolczynnika wypetnienia.

Skuteczno$é¢ spelnienia swojej roli przez dlawik i kondensator jest $cisle powigzana z
wartosciami tych elementow. Jak pokazaliSmy w paragrafach 3.1.d i 3.1.f, zapewnienie ciaglego
przeptywu pradu wymaga odpowiednio duzej indukcyjnosci, zas wygladzenie napigecia wyjsciowego
- odpowiednio duzej pojemnoéci. Tym samym - na podstawie zaleznosci (3.9) i (3.23) — elementy te
muszg mie¢ zdolno$¢ zmagazynowania odpowiednio duzej energii. Ta z kolei w niekorzystny
sposob wiaze si¢ z gabarytami elementu - im wieksza energie chcemy zmagazynowac¢, tym
wieksza i ciezsza musi by¢ cewka lub kondensator. Rownoczesnie wieksza bedzie pasozytnicza
rezystancja elementu biernego, przez co zwiekszeniu ulega moc strat w przeksztaltniku, a tym
samym obniza sie jego sprawnosc¢.
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Spojrzmy jednak na rys. 10, ktory — co do ksztaltu przebiegéw - stosuje sie zaréwno do cewki i
jej pradu, jak i do kondensatora i napiecia na nim. Z zamieszczonego zestawu wykreséw wynika, ze
jezeli proporcjonalnie skroci¢ czas trwania obu taktow, czyli zwiekszy¢ czestotliwosé
przelaczania f;, prad zdazy narosnac i opas¢ o mniejsza warto$¢ Air. Amplituda zmian zmniejszy si¢
wiec, czyli dzialanie elementu biernego bedzie bardziej skuteczne. Napiecie wyjSciowe nie
ulegnie za$ zmianie, gdyz zgodnie z zalezno$cig (3.53), nie zalezy ono od dilugosci okresu T, a
jedynie od stosunku czasu trwania obu taktéw - czyli wspolczynnika wypelnienia D. Rozumujac
odwrotnie, taka sama skuteczno$¢ dzialania mozna uzyskac¢ z uzyciem dlawika o mniejszej
indukcyjnosci. Analogiczny wniosek dotyczy pojemnosci kondensatora.

Powyzsze spostrzezenie stanowi glowny argument na rzecz wysokiej czestotliwosci pracy
wszelkich przeksztaltnikow o dzialaniu przelaczajacym. Ze wzoru (3.69) i analizy przeprowadzonej
w par. 3.3.e wynika jednak, ze wzrostowi czestotliwosci przelaczania towarzyszy wzrost mocy
strat dynamicznych w tranzystorze. Mozna to skompensowa¢ wylacznie przez zastosowanie
lacznika polprzewodnikowego o wiekszej szybkosci dzialania, tj. krotszych czasach
przelgczania — spadek sprawnosci zalezy bowiem od iloczynu tewfs (por. rys. 18). Sterowalnymi
przyrzadami polprzewodnikowymi mocy o najkroétszych czasach przelaczania sa obecnie
tranzystory MOSFET. Tlumaczy to ich dominacje w ukladach przetwornic pradu statego o
dzialaniu przelaczajacym.

Dodatkowy zysk z zastosowania tranzystorow MOSFET plynie z polowego mechanizmu
sterowania. Daje on:

1° bardzo mala moc sterowania (zar6wno w poréwnaniu do mocy przetwarzanej
w ukladzie, jak i do mocy strat w obwodzie gldéwnym tranzystora) — dzieki
czemu uktad sterowania nie obniza sprawnosci uktadu, jak to ma miejsce w
przypadku sterowanych pradowo tranzystorow BJT;

2° mozliwos¢ sterowania facznikiem potprzewodnikowym bezposrednio z wyjsé
ukladow scalonych (gdyz sterowanie odbywa sie zasadniczo poprzez sygnat
napieciowy, a nie pragdowy) — co upraszcza realizacje cyfrowych ukladow
sterowania.
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3.4. Podejscie energetyczne do analizy przetwornic

3.4.a. Zwiazek wspotczynnika przetwarzania napiecia ze sprawnoscia

Juz poréwnanie rys. 17a i 17b prowadzi do istotnej obserwacji, iz odstepstwo od idealnej
charakterystyki przetwarzania jest tym wyraZniejsze, im bardziej sprawno$¢ odbiega od
wartosci idealnej (1 = 1). Intuicyjnie mozna to wyjasni¢ nastepujaco. Wytworzenie okreslonego
napiecia wyjsciowego U, wymaga przeplywu przez odbiornik pradu o wartosci Us/RL i wobec tego
dostarczenia na wyjscie konkretnej mocy, o wartosci

Uz
P =UI, ==° (3.83)
RL

Przy sprawnosci 1 < 1 cze$¢ mocy wejsciowej jest tracona w przeksztaltniku, a wiec nie dociera do
odbiornika. Skoro tak, to moc wyjsciowa bedzie mniejsza, skad - odwracajac powyzszy wzor do
postaci

U, =+[P.R, (3.84)

o o

dochodzimy do wniosku, ze napiecie wyjsciowe bedzie mniejsze niz oczekiwane.

Aby wyrazi¢ powyzszy zwiazek ilosciowo, nalezy odwola¢ si¢ do réwnania energetycznego
przetwornicy, tj. zaleznosci miedzy moca czynnag wejsciowa a wyjSciowa. Wynika ono wprost z
definicji sprawnoéci:

P
P =— (3.85)
Przy zalozeniu stalosci napigcia wejsciowego, moc czynna wejsciowa P; wyraza si¢ wzorem (3.71);
moc wyjsciowg wyraza natomiast wzor (3.83). Powyzsza roéwnos$é mozna wiec rozwina¢ do

vr, =p=t U (3.86)
i71(0) i ,7

SRR

Jak stwierdziliSmy w par. 3.2.d, prad wejSciowy jest rowny pradowi dlawika przez czas, gdy
tranzystor jest zalaczony, z czego wyprowadzilismy (3.60). Tamta zalezno$¢ obowiazuje takze dla
przetwornicy stratnej, gdyz zostala wyprowadzona z pradowego prawa Kirchhoffa zastosowanego
do wezla, w ktéorym lacznik polprzewodnikowy laczy sie z dlawikiem; musi byé¢ ono zachowane
zawsze, niezaleznie od strat energii w ukladzie. Z kolei z pragdowego prawa Kirchhoffa dla wezla
wyjsciowego oraz zalozenia o idealnej filtracji uzyskaliSmy (3.35). Oba prady (wejsciowy i
wyjsciowy) daja sie wiec wyrazi¢ poprzez skltadows stalg pradu dlawika:

U,I
U,DI, o =——2 (3.87)
n
Stad po przeksztalceniu
UO
KU = U :/7D (3.88)

i
Poréwnujac powyzszy wynik z (3.55) stwierdzamy, ze wspolczynnik przetwarzania napiecia
przetwornicy obnizajacej rzeczywistej (stratnej) jest mniejszy niz dla przetwornicy idealnej

(bezstratnej) w stosunku rownym sprawnosci tej przetwornicy:
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Ky =nKyiq (3.89)

Innymi slowy, jezeli na wejécie przetwornicy podamy okre$lone napiecie Ui i bedziemy sterowac jej
tranzystorem sygnalem o okreslonym wypelieniu D, to w rzeczywistej przetwornicy obnizajacej
otrzymamy napiecie wyjSciowe mniejsze niz w przetwornicy idealnej, w stosunku réownym
sprawnosci tej pierwsze;.

Zauwazmy, ze uzyskany wynik jest zgodny z zaleznosciami pokazujacymi wplyw mocy strat
statycznych w tranzystorze na dziatanie ukiadu, wyprowadzonymi w par. 3.3. Wspoélczynnik
przetwarzania napiecia (3.79) i sprawnos¢ (3.80) taczy bowiem faktycznie relacja (3.88).

3.4.b. Wplyw strat mocy na prad wejsciowy
Na koniec powréémy jeszcze do rozwazan rozpoczetych w par. 3.2.d. Do uzyskanego tam

wyniku [réwnanie (3.63)] mozna takze doj$¢ droga analizy energetycznej, co jest nawet prostsze.
Przeksztalcajac (3.86) dostajemy bowiem bezposrednio

Po Uo Io KU
Lig =——=——"=1,—~ (3.90)
nu; U, n n

Otrzymana zalezno$¢ stanowi w istocie uogoélnienie wzoru (3.60), co wida¢, gdy podstawi sie do
niego (3.88). Wzor tamten obowiazywal wylacznie dla konkretnej topologii - przetwornicy
obnizajacej. Natomiast réwnanie energetyczne (3.86) i zalezno$¢ (3.90) sa uniwersalne -
prawdziwe nie tylko dla rzeczywistej (stratnej) przetwornicy obnizajacej, ale rowniez w
ogole dla dowolnej przetwornicy pradu stalego. Zaleznosci wykorzystane do ich
wyprowadzenia nie byly bowiem powiazane z konkretna topologia ukladu, ani nie byly uzaleznione
od zalozenia jednostkowej sprawnosci.

Wzér (3.90) pozwala projektantowi przewidzieé natezenie pradu wejSciowego niezbedne do
przeksztalcenia napiecia w zadanym stosunku Ky, przy obcigzeniu I, i zakladanej sprawnosci 7.
Mowi on, ze sktadowa stata pradu wejsciowego jest:

1° proporcjonalna do pradu wyjsciowego w stosunku odwrotnym do stosunku
napiec¢ (L)/ I < Uo/ Uy),

2° odwrotnie proporcjonalna do sprawnosci przetwornicy (ktora jest liczbg
mniejsza od 1, dlatego dzielenie przez nig oznacza powiekszenie wyniku).

Tak wiec przetwornica pobiera tym wiekszy prad wejsciowy (w sensie sktadowej stalej), im:

1° wigkszy stosunek napiecia wyjsciowego do wejsciowego — co oznacza, ze
gdy przetwornica obniza napiecie, to prad wej$ciowy jest mniejszy od
wyjsciowego i na odwrot,

2° mniejsza sprawnos$¢ przetwornicy - co wynika wprost z rOwnania
energetycznego (3.86), gdyz przy danym napieciu wejsciowym U;, jezeli
sprawnos$¢ n jest mniejsza, to dostarczenie okreslonej mocy wyjsciowej P,
wymaga przeptywu wiekszego pradu wejsciowego, aby lewa i prawa strona
roéwnania bilansowaly sie.
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Doswiadczenie

4. Pomiary

4.1. Uktad pomiarowy

Ogolny schemat badanego uktadu przetwornicy dtawikowej obnizajacej napiecie przedstawiono
na rys. 19. Skrajne gniazda bananowe umozliwiaja dotaczenie zasilania (napiecie wejsciowe U i
odbiornika R:. Na state w ukladzie znajduje sie tacznik polprzewodnikowy, tj. tranzystor T i dioda
D, oraz kondensator wejsciowy C; ktorego zadaniem jest zapewnienie stalosci napiecia
wejsciowego. Niebieska listwa zaciskowa umozliwia montaz dlawika (cewki) L lub wykonanie
zwarcia. Kondensator C montuje sie w dodatkowych wtykach bananowych umieszczonych
poprzecznie we wlasciwych wtykach odbiornika.

Wartoéci elementéw uktadu wynosza:
= rezystancja odbiornika Ry = 4,7 Q,
= indukcyjnosé dlawika L = 150 pH,
= pojemnos¢ kondensatora wyjsciowego C = 100 pF.

Poprzez gniazda bananowe wyprowadzone zostaly potencjaly najwazniejszych punktow.
Pomiar napieé¢ za pomocg sond oscyloskopowych dokonuje sie za posrednictwem wtykow
bananowych z koncéowkami umozliwiajacymi przylaczenie sondy. Wtyki te mozna dowolnie
przenosi¢c w zaleznosci od biezacych potrzeb pomiarowych. Natomiast obserwacja przebiegow
pradow jest mozliwa przez zalozenie sondy pradowej na jednym z wyprowadzonych fragmentow
przewodow (i, ir, ip) lub na przewodzie przylagczonym odpowiednio do wejscia albo wyjscia uktadu
(i, Io).

Impulsowy przebieg sterujacy tranzystorem u, pochodzi z zewnetrznego generatora
funkcyjnego (ugen). Poniewaz masa generatora jest uziemiona, do tego samego punktu nalezaloby
przylacza¢ masy wszystkich sond napieciowych (réwniez uziemione). Znaczaco utrudnitoby to
pomiary napie¢ wzgledem innych punktéw ukladu; dlatego tez w obwodzie zastosowano scalony
polprzewodnikowy optyczny uktad izolujacy (optoizolator) z diodg elektroluminescencyjna,
fotodioda i odpowiednim obwodem kondycjonujacym.

Sygnal z generatora ugen poprzez optoizolator trafia na wejscie sterownika bramki jako ug.
Sterownik na swoim wyjsciu podaje przebieg o identycznym ksztalcie, ale zoptymalizowany pod
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katem przelaczania szybkich tranzystoréw MOSFET mocy: o wyzszym poziomie grzbietu i bardziej
stromych zboczach, jednocze$nie zapewniajac odpowiednio duzy chwilowy prad bramki (patrz
instrukcja 34, rozdz. 2). Przebieg napiecia sterujacego ug po przejSciu przez optoizolator jest
dostepny w gniezdzie bananowym. Natomiast na bramke tranzystora jest on podawany dopiero
po zalaczeniu sterownika bramki, co dokonuje sie poprzez wecisniecie przycisku na panelu
ukladu (na rys. 19 pominietego): zielonego (zalaczenie na czas przytrzymania) lub czerwonego
(zalaczenie na stale). Praca sterownika sygnalizowana jest przez z6ttg kontrolke.

ut

J _I } ip Listwa : i
U —( G o & lUD L_b,ktj L T C H RL
Ugen

abzyE

Optoizolator

+ &

Uga

-0

Rys. 19. Schemat uktadu doswiadczalnego przetwornicy obnizajqcej napigcie

Obwod sterowania, tj. wyjscie optoizolatora i sterownik bramki, wymaga osobnego zasilania
Usc. Do zasilenia ukladu uzywane bedg dwa zasilacze:

= 0 duzej wydajnosci pradowej — do obwodu mocy (1),
= standardowy — do obwodu sterowania (Usg).

W zaleznosci od stanowiska, rejestracji danych z oscyloskopu dokonuje sie za pomocg
programu WaveStar for Oscilloscopes (oscyloskop TDS224) lub OpenChoice Desktop (oscyloskop
TDS1002B). Sposob postepowania zostal opisany w dalszym ciagu niniejszej instrukeji, z podaniem
oznaczenia oscyloskopu w przypadku, gdy procedury sg odmienne.

© 2017 Lukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki todzkiej



Pomiary C4+47

4.2. Przygotowanie do pomiarow

Konfiguracja uktadu pomiarowego

Schemat blokowy ukiadu pomiarowego z uwzglednieniem dwoéch mozliwych stanowisk
przedstawia rys. 20. Jego zestawienia i konfiguracji nalezy dokonaé¢ w sposéb opisany nizej i w
podanej kolejnosci. Jezeli w danym punkcie podane jest oznaczenie modelu oscyloskopu, oznacza to,
iz punkt ten dotyczy tego wlasnie modelu, natomiast nie nalezy go wykonywa¢ w przypadku
korzystania z innego modelu.

Aby nie traci¢ czasu, rownolegle z pkt. 1 nalezy wykonywac¢ kolejne punkty.

1. Wilacz komputer. Po zakonczeniu logowania, wlacz oscyloskop i skonfiguruj polaczenie z
komputerem postepujac $cisle wedtug instrukeji dostepnej na stanowisku.

2. Upewnij sie, ze zasilacze sa wylaczone. Przytacz:

= zasilacz o wydajnosci pradowej min. 10 A i wydajnosci napieciowej min. 40 V (ktoére to
parametry sa podane na jego obudowie) — do wejscia Ui na panelu ukladu,

= jedng z sekcji nastawnych standardowego zasilacza 2- lub 3-sekcyjnego - do wejscia
zasilania obwodu sterowania (Usg).

Nie nalezy uziemia¢ zasilania korzystajac z gniazd GND.

3. Wlacz niezalezny tryb pracy sekcji nastawnych zasilacza obwodu sterowania (Independent) za
pomoca dwoch przyciskow posrodku panelu przedniego.

4. Skre¢ wszystkie pokretla obu zasilaczy do zera (skrajne potozenie przeciwne do ruchu
wskazdéwek zegara).

5. Do wyjscia uktadu badanego (u,) przylacz odbiornik RL w postaci zamontowanego na radiatorze
zestawu opornikow.

6. Za pomocy dostepnej na stanowisku zwory, zewrzyj oba gniazda niebieskiej listwy zaciskowej
na panelu badanego uktadu.

7. Korzystajac z trojnika, wyjscie generatora funkcyjnego (Main Output) polacz z:
* wejéciem ugen ukladu badanego oraz
= [TDS224] wejsciem kanatu 3 oscyloskopu.
= [TDS1002B] wejéciem wyzwalania (Ext Trig) oscyloskopu.

8. Sondy napieciowe z ttumieniem 1:10 ([TDS1002B] ktére nalezy wybraé przetgcznikiem na korpusie
sondy — 10x) przylaczone do wejs¢ oscyloskopu podlacz tak, aby mierzy¢:
* na kanale 1 — napiecie sterujace bramka tranzystora T ug;

= [TDS224] na kanale 2 - napiecie wyjSciowe przetwornicy uo.

Masy sond napieciowych (koncéwki krokodylkowe) sa na oscyloskopie zwarte ze soba i
polaczone z przewodem ochronnym sieci; w zwiazku z tym musza by¢ zawsze przylaczone
do tego samego potencjalu. Inne polaczenie grozi przeplywem pradu przez oscyloskop i
uszkodzeniem jego obwodow wejsciowych!

9. Wygeneruj przebieg sterujacy:
a) wilacz generator funkcyjny;

b) ze strony internetowej uzyskaj i zanotuj czestotliwo$¢ przelgczania przetwornicy f;;
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Rys. 20. Schemat blokowy uktadu pomiarowego do rejestracji przebiegow w funkcji czasu:
a) z oscyloskopem TDS224; b) z oscyloskopem TDS1002B
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10.

11.

c) na generatorze:

Zatwierdzenie wartosci liczbowych wprowadzanych z klawiatury generatora nastepuje przez
wecisniecie odpowiedniego klawisza jednostki z prawej strony.

= wybierz przebieg prostokatny (przycisk Func),
= ustaw amplitude (Ampl) 10 V (warto$¢ miedzyszczytowa — Vpp),
= ustaw czestotliwos¢ (Freq) ustalong wyzej;

= ustaw wspolczynnik wypelnienia (Duty) D=0,35 (na generatorze wspoélczynnik
wypelnienia wyrazany jest w procentach).

Przed kontynuacja poprawnos¢ polaczen musi sprawdzi¢ prowadzacy!

Podczas wykonywania kolejnego punktu nalezy uwazaé¢, aby w czasie regulacji nie
przekroczy¢ nigdy wartosci 18 V, gdyz grozi to zniszczeniem ukladow scalonych. Punkt ten
nalezy najpierw przeczytac¢ w calosci, a dopiero pdzniej przystapi¢ do jego wykonania.

Podczas wykonywania kolejnego punktu przy poprawnej pracy ukladu zasilacz powinien
wykazywa¢ pobor pradu rzedu dziesiatek miliamperow. Jezeli obserwowane jest co innego,
nalezy go wylaczy¢ i poprosi¢ prowadzacego o ponowne sprawdzenie ukladu.

Zasil obwod sterowania:

a) wlacz zasilacz obwodu sterowania;

b) zwieksz nieco prad graniczny odpowiedniej sekcji (pokretto Current) do zgasniecia
czerwonej kontrolki ograniczenia pradowego (C.C.);

c) ustaw napiecie zasilania (pokretlo Voltage) na 15 V. Jezeli w trakcie nastawiania napiecia
wlaczy sie ograniczenie pradowe, nalezy najpierw zmniejszy¢é napiecie, zwiekszy¢ prog
ograniczenia pragdowego i dopiero woéwczas ponownie sprobowac zwiekszy¢ napiecie;

d) po pomyslnym nastawieniu napiecia, zwieksz prad graniczny mniej wiecej o jeszcze raz taka
samg wartos$¢, jak ustawiona do tej pory (na oko).

Sprawdz, czy sterownik bramki jest wylaczony, o czym $wiadczy zgaszona zoétta kontrolka na
panelu uktadu. W przeciwnym razie wylacz go wciskajac czerwony przycisk.

Konfiguracja oscyloskopu

12.

13.

Za pomoca programu do komunikacji z oscyloskopem, wczytaj do oscyloskopu ustawienia
poczatkowe:

[TDS224]

= z menu wybierz File » Open i otworz plik ustawienia_3b_przeb_tds224.sht, w kolejnym
oknie dialogowym wybierajac Offline;

= na licie w lewym panelu bocznym rozwin: zainstalowany oscyloskop » Data » Settings,

= w oknie pliku ustawien zaznacz cala jego zawartosc¢ i przeciggnij mysza do pozycji Full
Setup w lewym panelu bocznym;

= zaczekaj na zakonczenie wprowadzania zmian na oscyloskopie, o ktérego trwaniu
$wiadcza zmiany elementéw ekranu (liter, cyfr, krzywych).
[TDS1002B]
= przejdz do zakladki Get & Send Settings;
= wecisnij Open i wezytaj plik ustawienia_3b_przeb_tds1002b.set;
= wcisnij Send Settings;
= wrdc¢ do zakladki Screen Capture.

Za pomocy przyciskow CH1/2/3/4 Menu na oscyloskopie, wyswietl przebieg z kanatu 1, ukryj ze
wszystkich pozostatych.
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Na ekranie oscyloskopu powinien wyswietla¢ sie stale od$wiezany i stabilny przebieg
impulsowy, o czym $wiadczy miedzy innymi komunikat ,Trig’d” (Triggered) wys$wietlany nad
podzialka. Jezeli nie ma to miejsca, popro$ prowadzacego o sprawdzenie ustawien oscyloskopu.

Przyciski CHx Menu (gdzie x — numer kanalu) powodujg naprzemienne wys$wietlanie i ukrywanie
przebiegu z danego kanalu oscyloskopu. Wyswietlanie danego przebiegu sygnalizowane jest przez
strzatke wskazujaca poziom zera z lewej strony podzialki oraz przez symbol kanatu ,CHx” pod
podziatka.

14. Wyreguluj:
= podstawe czasu i polozenie chwili wyzwolenia (pokretla Sec/Div i Horizontal Position)
tak, aby widocznych bylo 3-5 okresow napiecia u; (chwila wyzwalania, wskazywana

przez strzalke nad podziatka, musi znajdowac sie na ekranie, tj. nie moze znajdowacé sie
na zadnym z krancéw podziatki);

= wzmocnienie kanalu 1 i polozenie poziomu zera (pokretta CHI Volts/Div i Position) tak,
aby przebieg byl dobrze widoczny, znajdowat sie na samym dole ekranu i zajmowat w
pionie mniej wiecej 1 dziatke.

W niniejszym ¢wiczeniu wystepujace w przebiegach krotkie szpilki lub oscylacje nalezy
zawsze zaniedbywac.
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4.3.

Rola elementéw przetwornicy

Zasilenie uktadu

Upewnij sie, ze zadne przewody nie dotykaja opornika-odbiornika, jego radiatora, ani radiatora
przetwornicy znajdujacego si¢ z tylu jej obudowy. Dotyczy to réwniez przewodéw sond
napieciowych. W przeciwnym razie izolacja przewodéw moze ulec stopieniu.

Powyzsze warunki muszg by¢ zachowane przez caly czas wykonywania ¢wiczenia!

Zasil obwod mocy:
a) wilacz zasilacz obwodu mocy;

b) ustaw maksymalny prad graniczny ograniczenia pradowego (pokretlo nastawy zgrubnej
Current Coarse);

c) ze strony internetowej uzyskaj i zanotuj napiecie wejsciowe Uj;

d) powoli ustaw ustalong wyzej wartos¢ napiecia (nastawa zgrubna — Voltage Coarse, nastawa
doktadna - Voltage Fine), kontrolujac, czy amperomierz zasilacza nie wykazuje stalego
poboru pradu - w przeciwnym razie wylacz zasilacz i popros§ prowadzacego o ponowne
sprawdzenie ukladu.

Po wykonaniu kolejnego punktu, przy poprawnej pracy ukladu pobér pradu wykazywany
na amperomierzu zasilacza obwodu mocy powinien mie¢ wartos$é bliska, lecz nie wieksza niz
przewidywana dla przetwornicy idealnej — wzor (3.64) [niezbedne wartosci — patrz pkt. 4.1,
4.2/9.c) oraz 2.c) powyzej]. Jezeli obserwowane jest co innego, nalezy wylaczyé zasilacz
obwodu mocy i poprosi¢ prowadzacego o ponowne sprawdzenie ukladu. W dalszym ciagu
¢wiczenia prad ten bedzie osiggac¢ wieksze wartosci.

Wilacz przetwornice zapewniajac bezproblemowa prace w calym pozadanym zakresie
wspolczynnika wypelnienia:

a) czerwonym przyciskiem wlacz sterownik bramki tranzystora;

Kiedy przetwornica pracuje (sterownik bramki jest wlaczony, a wejscie mocy - zasilone), na
miernikach zasilacza obwodu sterowania moga by¢ wykazywane znaczace prady i napiecia.
Wynika to z przenoszenia si¢ szybkozmiennych zaburzen przy braku uziemienia zasilacza. Nie
$wiadczy to o niepoprawnej pracy uktadu.

b) sprawdz, czy nie uaktywnilo sie ograniczenie pradowe zasilacza obwodu sterowania; jezeli
tak — zwigksz prog ograniczenia pradowego;

c) na generatorze funkcyjnym ustaw maksymalny wspolczynnik wypelnienia, tj. 0,8;
d) powtorz ppkt. b);

e) przywrdoc wspolezynnik wypelnienia 0,35.

Konfiguracja pomiaru napiecia

4.

[TDS224] Wyswietl przebieg z kanatu 2 (CH2 Menu). Wyreguluj wzmocnienie kanatu 2 i polozenie
poziomu zera (pokretta CHZ2 Volts/Div i Position) tak, aby przebieg byt dobrze widoczny i nie
nakladal sie na przebieg napiecia ug, zajmujac w pionie dolng 1/3-1/2 ekranu (nie wigcej).

[TDS1002B] Na oscyloskopie wyswietl przebieg napiecia wyjSciowego u, nie tracgc obrazu
napiecia ug:

a) zapisz przebieg napiecia sterujacego u; w pamieci oscyloskopu:

=  weci$nij Save/Recall,

= wybierz zapis przebiegu - odpowiednim przyciskiem obok ekranu ustaw Action: Save
Waveform,
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= wybierz zapis do pamieci oscyloskopu - Save To: Ref,

= jako zrodlo wybierz przebieg z kanatu 1 - Source: CHI,

= jako lokalizacje docelowa wybierz pamie¢ A — To: RefA,

= wci$nij Save;

Od tego momentu az do konca wykonania ¢wiczenia, pod zadnym pozorem nie nalezy
zmienia¢ podstawy czasu (Sec/Div) ani polozenia chwili wyzwalania (Horizontal

Position)! Spowodowaloby to rozsynchronizowanie kolejnych oscylogramoéow wzgledem
siebie i tym samym uniemozliwiloby ich analize na etapie opracowywania wynikow.

b) wyswietl przebieg u; z pamieci A — wcisnij Ref Menu, a nastepnie za pomoca odpowiedniego
przycisku obok ekranu ustaw Ref A: On;

Przebieg u; z pamieci powinien zacza¢ by¢ widoczny w tle ekranu. Mozna to sprawdzic
przesuwajac nieco przebieg u, z kanatu 1 pokrettem Vertical Position.

c) przeloz sonde z kanatu 1 tak, by mierzy¢ napiecie wyjsciowe przetwornicy uo;

d) wyreguluj wzmocnienie kanatu 1 i polozenie poziomu zera (pokretta Volts/Div i Position) tak,
aby przebieg byt dobrze widoczny i nie nakladat si¢ na przebieg napiecia u,, zajmujac w
pionie dolng 1/3-1/2 ekranu (nie wiecej).

Konfiguracja pomiaru pradu

6.

Skonfiguruj wzmacniacz sondy pradowej i jego polaczenie z oscyloskopem postepujac wedlug
dostepnej na stanowisku instrukcji do sondy. Uwzglednij, ze prad w obwodzie w najgorszym
wypadku moze osiggnaé wartosé rowng ilorazowi napiecia zasilania U; [patrz pkt 2.c)] i
rezystancji odbiornika Ry, (patrz pkt 4.1). Wyjscie wzmacniacza przylacz do ostatniego kanatu
oscyloskopu (odpowiednio 4 lub 2). Obowigzkowo przeczytaj i zastosuj sie do podanych w
instrukcji do sondy wskazowek dotyczacych konfiguracji oscyloskopu.

Na wzmacniaczu sondy ustaw sprzezenie z przenoszeniem skladowej statej — Coupling: DC.

Zamknij sonde wokot przewodu wiodacego prad dlawika (aktualnie nieobecnego w ukladzie) i
tak, by kierunek dodatni pradu wskazywany przez strzalke na koncu sondy byl zgodny z
rzeczywistoscig (por. rys. 20).

Na oscyloskopie wyswietl przebieg iL (odpowiedni z przyciskow CH1/2/3/4 Menu) i dostosuj:

= wzmocnienie w torze pomiarowym (na wzmacniaczu lub na oscyloskopie - zgodnie z
opisem w instrukeji do sondy, nie w zaden inny sposdb), oraz

= polozenie przebiegu - pokretlem Position odpowiedniego kanatu (na oscyloskopie),

tak, aby przebieg pradu byl dobrze widoczny od swojego poziomu zera, wskazywanego przez
strzatke z numerem kanatu z lewej strony podziatki, do swojej wartosci szczytowej i nie naktadat
sie na pozostale przebiegi, zajmujac gorng 1/3-1/2 ekranu.

Wptyw elementéw na dziatanie uktadu

10. Zarejestruj komplet 3 przebiegéw {ug; uo; iL}:

[TDS224]
a) w programie WaveStar utworz nowy arkusz typu YT Sheet;

b) z panelu bocznego (Local » oznaczenie oscyloskopu » Data » Waveforms » oznaczenie kanatu)
do utworzonego arkusza przeciagnij 3 przebiegi (ug, o, iL) wySwietlane na ekranie
oscyloskopu;

Raz przeciagniete przebiegi wystarczy pdzniej tylko od$wiezaé wciskajac przycisk Refresh Sheet
lub z menu View » Refresh Datasheet.

Przebieg mozna usuna¢ z arkusza klikajac na jego numerze z lewej strony podziatki i wciskajac
klawisz Delete.
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11.

12.

13.

14.

c) arkusz, zawierajacy wszystkie 3 przebiegi jednoczes$nie, zapisz w formacie programu
WaveStar (SHT) — przycisk Save Datasheet lub z menu File » Save Datasheet As;

Nie nalezy uzywac funkcji Save Worksheet, ktéra nie powoduje zapisania zadnych danych
pomiarowych, a jedynie nazwy otwartych arkuszy.

d) zanotuj biezace ustawienie wspoélczynnika przetwarzania sondy pradowej (patrz sekcja
~Przetwarzanie prad-napiecie” w instrukcji do uzywanej sondy).

[TDS1002B]

a) w programie OpenChoice Desktop przejdz do zakladki Screen Capture;

b) pobierz obraz ekranu na komputer — wcisnaé Get Screen;

c) zapisz oscylogram w formacie graficznym — wcisnaé Save As.

Wiacz w uklad dlawik L:

a) odlgcz sonde pradowsg od ukladu;

b) wylacz sterownik bramki tranzystora, a nastepnie zasilacz obwodu mocy;

c) w miejsce zwory, w niebieska listwe zaciskowa na panelu uktadu wlacz dtawik;

d) zwore umie$¢ na powro6t w torebce w celu zapobiegnigcia jej zagubieniu;

e) wlacz zasilacz obwodu mocy, a nastepnie sterownik brambki;

f) ponownie zamknij sonde pradowa wokot przewodu wiodacego prad dtawika ir.

Nie zmieniajgc zadnych ustawien na oscyloskopie ani wzmacniaczu sondy pradowej, ponownie
zarejestruj zestaw przebiegow:

[TDS224]

a) odswiez zawarto$¢ arkusza YT Sheet wciskajac przycisk Refresh Sheet lub z menu View »
Refresh Datasheet;

b) zapisz arkusz w formacie programu WaveStar (SHT).
[TDS1002B]

a) pobierz obraz ekranu na komputer — wcisna¢ Get Screen;
b) zapisz oscylogram w formacie graficznym.

Wilacz w uklad kondensator C (dtawik pozostawic¢ w ukladzie):
a) odlacz sonde pradowsg od ukladu;

b) wylacz sterownik bramki tranzystora;

¢) na wyjscie ukladu (u,), réwnolegle do odbiornika (zgodnie z rys. 19, zob. opis w par. 4.1),
wlacz kondensator, zwracajgc uwage na jego poprawng polaryzacje (na obudowie
oznaczony jest biegun ujemny);

Poprawnos¢ wlaczenia musi sprawdzi¢ prowadzacy!

d) wlacz sterownik bramki;
e) ponownie zamknij sonde pradowa wokot przewodu wiodacego prad dtawika ir.
Powtorz pkt 12.

Dwupozycyjny tacznik potprzewodnikowy

15.

Zoptymalizuj nastawy w torze pomiarowym pradu w obecnych warunkach pomiaru:

a) zmodyfikuj wzmocnienie (na wzmacniaczu lub na oscyloskopie -_zgodnie z opisem w
instrukcji do sondy) oraz polozenie przebiegu (pokretlo Position na oscyloskopie) - tak, aby
dostosowac je do obecnie obserwowanych wartosci pradu, ktérego przebieg powinien
zajmowaé gorng 1/3-1/2 ekranu od swojego poziomu zera do swojej wartosci szczytowej;

b) [TDS224] zanotuj biezace ustawienie wspolczynnika przetwarzania wzmacniacza sondy
pradowej;
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16.

17.

18.

c) [TDS1002B] zarejestruj zestaw przebiegéw {ug, i} przy aktualnych nastawach - pobierz
oscylogram i zapisz go w formacie graficznym.

Kolejny punkt nalezy wykonywaé ze szczegdlna ostroznoscia, tak by nie doprowadzi¢ do
przypadkowego zwarcia roznych punktow ukladu przez masy sond oscyloskopowych.

* Przeldz sondy napieciowe:
[TDS224]
a) odlgcz sondy napieciowe (zaréwno koncoéwki gorace, jak i masy) od uktadu;

b) masy obu sond przylacz do tego samego punktu - wspoélnego wezta tranzystora (zrodlo) i

diody (katoda);
c) koncoéwki gorace przylacz tak, aby mierzyc¢:
= na kanale 1 - napiecie na diodzie up,
= na kanale 2 - napiecie na tranzystorze ur;

d) w razie potrzeby dostosuj wzmocnienia i potozenie poziomu zera kanatéow 1 i 2 (Volts/Div,
Position).

[TDS1002B]

a) odlgcz sonde napieciowa od ukladu;

=3

) mase sondy przylacz do wspdlnego wezla tranzystora (2rédlo) i diody (katoda);

e

) koncowke goraca przylacz tak, aby mierzy¢ napiecie na diodzie up;

o

) w razie potrzeby dostosuj wzmocnienie i potozenie poziomu zera kanalu 1 (Volts/Div,
Position), tak by przebieg z tego kanalu nie nakladat si¢ na pozostate dwa przebiegi.

[TDS224] Zarejestruj komplet 3 przebiegow {iL, ip, it} (* 5 przebiegéw {up, ur, i, i, it}):

a) utworz nowy arkusz YT Sheet;

b) do arkusza YT Sheet przeciagnij przebiegi ug i iv (* up, ur i i), jednak na razie nie zapisuj
arkusza;

c) nie zmieniajac zadnych ustawien, przetdz sonde pradows tak, aby obserwowac prad diody
i, zachowujac kierunek dodatni mierzonego pradu zgodny z rzeczywistoscia (patrz rys. 20);

d) pobierz przebieg pradu na komputer ponownie przeciagajac odpowiedni kanat (poprzednich
przebiegéw nie usuwaj ani nie od$wiezaj oraz nie zapisuj arkusza); mozna wylgcznie
zmienic¢ kolor przebiegu i nieznacznie przesunaé go wzgledem pradu dlawika;

e) nie zmieniajagc zadnych ustawien, przeléz sonde pradows tak, aby obserwowaé prad
tranzystora ir, zachowujac kierunek dodatni mierzonego pradu zgodny z rzeczywistoscia
(patrz rys. 20);

f) pobierz przebieg pradu na komputer ponownie przeciagajac odpowiedni kanat (poprzednich
przebiegéw nie usuwaj ani nie od$wiezaj); mozna wylgcznie zmienié¢ kolor przebiegu i
nieznacznie przesunaé¢ go wzgledem poprzednio pobranych pradow;

g) zapisz arkusz zawierajacy pobrane 3 (* 5) przebiegdw w formacie programu WaveStar (SHT).

[TDS1002B] Zarejestruj zestawy przebiegow {ug, in} i {ug, it} (* {4, up, iv} i {ug, ur, i}):

a) nie zmieniajgc zadnych ustawien, przeldz sonde pradowsq tak, aby obserwowac prad diody
i, zachowujac kierunek dodatni mierzonego pradu zgodny z rzeczywistoscia (patrz rys. 20);

b) pobierz oscylogram przebiegdw ug i ip (* ug, up i ip) i zapisz go w formacie graficznym;

c) *przeldz koncowke goraca sondy napieciowej tak, aby mierzy¢ napiecie na tranzystorze ur;

d) *w razie potrzeby dostosuj wzmocnienie i polozenie poziomu zera kanatu 1 (Volts/Div,
Position);

e) nie zmieniajac zadnych ustawien, przeléz sonde pradowsa tak, aby obserwowaé prad

tranzystora ir, zachowujac kierunek dodatni mierzonego pradu zgodny z rzeczywistoscia
(por. rys. 19 i opis na panelu ukladu);

f) pobierz oscylogram przebiegow ug i it (* ug, ur i it) izapisz go w formacie graficznym.
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Pomiary C4+55

19. [TDS1002B] Ukryj przebieg u; pochodzacy z pamieci oscyloskopu: na oscyloskopie wcisnij Ref
Menu i wybierz Ref A: Off-

20. Wylacz sterownik bramki, a nastepnie zasilacz obwodu mocy.
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56+ C4

Przyrzady i uktady mocy — Cwiczenie 3B. Tranzystory MOSFET (6.8.0)

4.4.

Pomiar charakterystyk przetwornicy

Przetwornica jako przeksztattnik energii elektrycznej

Schemat blokowy ukiadu pomiarowego przedstawia rys. 21, na ktérym kolorem czarnym
oznaczono polaczenia do utworzenia lub modyfikacji w sposob opisany nizej; linie szare oznaczajg
polaczenia istniejgce nieulegajace zmianie.

Aby usprawni¢ wykonywanie ¢wiczenia, jedna osoba powinna wykonywa¢ pkt 1, podczas gdy druga
rownolegle rozpoczaé wykonywanie pkt. 2-3).

1. Za pomoca programu do komunikacji z oscyloskopem, wprowadz ustawienia umozliwiajace
pomiar wspolczynnika wypelnienia pradu tranzystora:

[TDS224]

= 7z menu wybierz File » Open i otworz plik ustawienia_3b_char_tds224.sht, w kolejnym
oknie dialogowym wybierajac Offline;

= w oknie pliku zaznacz calo$¢ instrukcji i przeciagnij mysza do pozycji Data » Settings »
Full Setup w lewym panelu bocznym.

[TDS1002B]

= przejdz do zakladki Get & Send Settings;

= wcisnij Open i wezytaj plik ustawienia_3b_char_tds1002b.set,
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Rys. 21. Schemat blokowy uktadu pomiarowego charakterystyk statycznych przetwornicy
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Pomiary

C4+57

2.

=  weci$nij Send Settings.

Przygotuj uklad do pomiaru napiecia wejsciowego i wyjsciowego:

a)

b)
©)

rownolegle do wejécia (Uj) i rownolegle do wyjscia (uo) — z uwzglednieniem wlgczenia
kondensatora w sposob pokazany na rys. 21 — przylacz 2 multimetry CD771 w sposéb
umozliwiajacy pomiar napiecia;

ustaw multimetry w tryb pomiaru napiegcia (V);

ustaw multimetry w tryb pomiaru sktadowej stalej (na wyswietlaczu symbol ==) - przycisk
niebieski.

Przygotuj ukltadu do pomiaru pradu wejsciowego i wyjsciowego:

a)

b)
¢)

w szereg z wejsciem (U;) — tj. miedzy zasilacz obwodu mocy a to wejScie — i w szereg z
wyjsciem (uo) — tj. miedzy to wyjscie a odbiornik, z uwzglednieniem wlaczenia kondensatora
w sposob pokazany na rys. 21 — przylacz 2 multimetry M-3860M w sposob umozliwiajacy
pomiar pradu o natezeniu rzedu amperow;

ustaw multimetry w tryb pomiaru pradu z uwzglednieniem powyzszego rzedu natezenia;

ustaw multimetry w tryb pomiaru skladowej stalej (na wyswietlaczu brak symbolu ,AC”) -
przycisk AC/DC.

Jezeli na wyswietlaczu miernika wyswietlony zostanie wskaznik rozladowania baterii
(symbol baterii), nie nalezy kontynuowa¢ pomiarow, a zwréci¢ si¢ do prowadzacego celem
jej wymiany. W przeciwnym razie wskazania miernika moga by¢ bledne.

Przed kontynuacja, poprawnos¢ wlaczenia miernikow musi sprawdzi¢ prowadzacy.

Wlacz zasilacz obwodu mocy, a nastepnie sterownik bramki.

Nie nalezy dotyka¢ opornikow odbiornika, gdyz grozi to oparzeniem. Nalezy ponownie
upewnic sie¢, ze zadne przewody nie dotykaja opornikow ani radiatora.

Uzyskaj poprawny pomiar czasu trwania impulsu pradu tranzystora:

a)

b)

d)

zmieniajagc wzmocnienie w torze pomiarowym pradu zgodnie z instrukcja do sondy
pradowej i ewentualnie polozenie przebiegu w pionie (pokretto Vertical Position), doprowadz
do tego, by grzbiet impulsu pradu znajdowat si¢ przy gornej granicy ekranu (moze on nawet
nieco poza niego wychodzi¢), zas§ wieksza cze$¢ szpilki widocznej na poczatku impulsu
znajdowala si¢ poza ekranem;

zmieniajgc podstawe czasu (Sec/Div) i polozenie chwili wyzwalania (Horizontal Position),
doprowadz do tego, by widoczny byl pojedynczy impuls zajmujac jak najwieksza czesc
ekranu w poziomie;

[TDS224] sprawdz, czy uzywany oscyloskop posiada modut TDS2MM umozliwiajacy
automatyczny pomiar czasu trwania impulsu, o czym $wiadczy obecno$é po prawej stronie
ekranu pola pomiarowego Pos Width (mozna to réwniez sprawdzi¢ weciskajac Utility i

wybierajac System Status — zainstalowany modul bedzie wykazany na gorze jako , TDS224
(...) - TDS2MM”);

w przeciwnym razie aktywuj kursory wciskajac Cursor;

[TDS1002B, TDS224z TDS2MM] sprawdz, czy w panelu po prawej stronie ekranu w polu
pomiarowym opisanym jako odpowiednio Ch2 albo Ch4, Pos Width, wyswietlana jest
warto$¢ w miare stabilna (od czasu do czasu moga pojawi¢ sie krotkie zaburzenia
wskazania) i odpowiada ona rzeczywistemu czasowi trwania impulsu, ktory nalezy odczytac¢
z ekranu za pomocg podziatki — w przeciwnym razie poprosi¢ o pomoc prowadzacego;

[TDS224 bez TDS2MM]  pokretlami Cursor 1 i Cursor 2 przesun kursory tak, by wskazywaly
poczatek i koniec impulsu.

Dla 7-15 punktéw pomiarowych wyznaczonych przez warto$¢ wspolczynnika wypetnienia D
zmieniajaca sie od minimalnej do maksymalnej mozliwej do uzyskania z uzyciem
wykorzystywanego generatora, tj. od 0,2 do 0,8, zanotuj wyniki nastepujacych pomiarow:
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58¢C4 Przyrzady i uktady mocy — Cwiczenie 3B. Tranzystory MOSFET (6.8.0)

a) z oscyloskopu - czas trwania impulsu pradu tranzystora #p(ir), kazdorazowo kontrolujac
poprawno$¢ obrazu i w razie potrzeby dokonujac odpowiednich modyfikacji ustawien jak w
pkt. 5:

= [TDS1002B, TDS224 z TDS2MM] wskazanie z pola odpowiednio Ch2 albo Ch4, Pos Width po
zgrubnym skontrolowaniu jego zgodnosci z obrazem na ekranie,

= [TDS224 bez TDS2MM] wskazanie z pola Delta po odpowiednim przesunieciu kursorow;

Nie nalezy traci¢ czasu na zapisywanie przebiegu z oscyloskopu, gdyz nie wniesie on do analizy
wynikéw niczego, czego nie moze wnie$¢ samo spisanie wyswietlanego czasu trwania impulsu,
ktore jednak trwa krdcej niz pobieranie oscylogramu i jego zapisywanie do pliku.

b) z multimetréw — wartosci sktadowej statej napiecia wejsciowego Ui, pradu wejsciowego I),
napiecia wyjsciowego U, oraz pradu wyjsciowego L.

Podobnie jak w analizie teoretycznej zakladamy, Ze tetnienie napiecia wejsciowego i napiecia
wyjsciowego jest pomijalnie mate, w zwiazku z czym przebiegi u;, u, i w konsekwencji i, mozna
uznaé za stale w czasie. Nie jest to natomiast mozliwe w odniesieniu do pradu wejsciowego i
dlatego wynik pomiaru multimetrem nalezy oznaczy¢ indeksem ,0” dla sprecyzowania, ze chodzi
wylacznie o jego skltadowa stala.

7. Ustaw wspotczynnik wypetnienia D = 0,5.
Zakonczenie pomiaréw

8. Wylacz sterownik bramki, nastepnie zasilacz obwodu mocy, nastepnie zasilacz obwodu
sterowania.

9. Na oscyloskopie wylacz ograniczenie pasma w kanale pomiaru pradu: wcisna¢ odpowiednio Ch2
lub Ch4 Menu i przyciskiem obok ekranu ustaw BW Limit: Off.

10. Wylacz multimetry.
11. Odlacz od uktadu sonde pradows.

12. Wymontuj dlawik, dokrecajac na powr6t Srubki w listwie zaciskowej. Wymontuj kondensator.
Umies¢ kondensator i dlawik w torebce wraz ze zwora.

13. Rozlacz uklad; nie odlaczaj jednak: sond napieciowych od oscyloskopu, sondy pradowej od jej
wzmacniacza, a wzmacniacza sondy od oscyloskopu.
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Wyniki

5. Opracowanie i analiza wynikow

5.1. Topologia przetwornicy obnizajacej

tacznik poétprzewodnikowy

1. W czeSci 1 sprawozdania zamie$é oscylogramy umozliwiajace zestawienie przebiegéw pradow
element6w i napiecia sterujacego:

[TDS224] zestaw {iL, ip, it} (*{up, ur, iL, ip, ir}) zarejestrowany w pkt. 4.3/17 oraz {ug, uo, i}
zarejestrowany w pkt. 4.3/14;

[TDS1002B] zestawy {ug, ip} i {ug, it} (* {ug, up, in} i {uyg, ur, it}) zarejestrowane w pkt. 4.3/18 oraz
{ug, iL} zarejestrowany w pkt. 4.3/15.c).

2. Uzupehij czes¢ 1 sprawozdania.
Rola elementéw uktadu

3. Wypelnij czes¢ 2 sprawozdania.
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5.2.  Charakterystyki uktadu i wptyw tranzystora
Sprawnos¢
1. W oparciu o wyniki pomiar6w dokonanych w pkt. 4.4/6, oblicz dla kazdego punktu

pomiarowego (zob. podrozdz. 2.3, 3.3 1 3.4):

a) faktyczny (tj. objawiajacy sie ostatecznie w obwodzie mocy, a wiec w pradzie tranzystora, a
nie podawany z generatora na wejscie ukladu sterowania) wspolczynnik wypelnienia D — ze
zmierzonego czasu trwania impulséw pradu tranzystora #p(ir) i znanej czestotliwosci ich
powtarzania fs (warto$¢ uzyskana ze strony internetowej w pkt. 4.2/9);

b) moc czynng wejSciowg P, — z odpowiednich zmierzonych napiecia i pradu (zakladajac, ze
napiecie wejSciowe ma przebieg staly w czasie);

¢) moc czynng wyjsciowg P, — z odpowiednich zmierzonych napiecia i pradu (zakladajac, ze
napiecie wyjsciowe ma przebieg staly w czasie);

d) sprawnos¢ energetyczng n — z definicji;

e) wspdlczynnik przetwarzania napiecia Ky — z definicji;

f) *iloraz pradéw Kj- z definicji przyjetej w niniejszej instrukeji (zob. podrozdz. 3.2).

2. Dla kazdej wartosci wspolczynnika wypelnienia D oblicz (zob. podrozdz. 3.3):

a) wspolczynnik przetwarzania napiecia przetwornicy idealnej (bezstratnej) Kuidq) — ze wzoru
analitycznego;

b) wzgledna réznice wspolczynnika przetwarzania napiecia ukladu rzeczywistego i idealnego
AKv/ Kud), gdzie AKy = Ky - Kuid) — na podstawie wynikéw z ppkt. a) i 1.e);

c) ”stosunek Ky / Kyia) — na podstawie wynikow z ppkt. a) i 1.e);

d) *stosunek zmierzonego ilorazu pradéw K; do jego teoretycznej wartosci Kiteor) (zob.
podrozdz. 3.2) — na podstawie wynikéw z ppkt. 1.1).

3.  Wyniki pomiardéw i obliczen zbierz w odpowiednich tabelach w czesci 3 sprawozdania.
4. Uzupenij czesé 3 sprawozdania.

Wspoétczynnik przetwarzania napiecia

5.

6.

Dla gestego zbioru wartosci wspoétczynnika wypelnienia D z calego przedzialu jego mozliwych
wartosci [0; 1] - tak aby w dalszym ciggu mozliwe bylo wykreélenie krzywej w pelnym zakresie
od 0 do 1 i sprawiajgcej wrazenie krzywej gladkiej — ponownie oblicz wspolczynnik
przetwarzania napiecia przetwornicy idealnej Kud). Uzyskane wartosci zamie$¢ w tabeli w czesci
4 sprawozdania.

Uzupelnij czes¢ 4 sprawozdania.

Minimalizacja mocy strat w tranzystorze

7.

Wypehnij czes¢ 5 sprawozdania.
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Informacje

6. Wymagana wiedza

6.1.

6.2.

Przygotowanie do wykonywania ¢wiczenia

Zasada sterowania impulsowego i parametry impulsu idealnego
(zob. par. 2.3)

Ogolna zasada dzialania przetwornicy pradu stalego obnizajacej napiecie (pelny
uklad z tranzystorem, diodg, dtawikiem i kondensatorem): schemat z tacznikiem
abstrakcyjnym i z tacznikiem potprzewodnikowym, dziatanie tgcznika, topologia
uktadu w dwoch taktach

(zob. par. 3.113.2)

Zakres kolokwium

Sterowanie impulsowe: zasada, parametry impulsu idealnego i rzeczywistego.
(zob. par. 2.3)

Zalety i wady przeksztaltnikow: elektromechanicznych, elektronicznych o dziataniu
ciaglym, elektronicznych o dziataniu impulsowym
(zob. par. 2.2 1 2.3)

Przetwornica pradu stalego obnizajgca napiecie: schemat (z tacznikiem
abstrakcyjnym i z tacznikiem potprzewodnikowym), tacznik dwupozycyjny i jego
dzialanie, rola kazdego z elementoéw biernych. Topologia uktadu (ostatecznego) w 2
taktach. Przebiegi pradéw i napiec¢: dtawika, tranzystora i diody w powigzaniu z
sygnatem sterujacym tacznikiem (z uwzglednieniem charakterystycznych wartosci
napie¢ i ich zwigzku z warunkami pracy uktadu).

(zob. par. 3.11 3.2, sprawozdanie)

Definicja sprawnosci oraz wspolczynnika przetwarzania napiecia. Charakterystyka
przetwarzania idealnej (bezstratnej) przetwornicy obnizajacej (wzor i wykres).
Charakterystyki sprawnosci przetwornicy obnizajacej (wykresy) — uwzgledniajaca
statyczne oraz uwzgledniajaca dynamiczne straty mocy w tranzystorze; wplyw
parametrow tranzystora. Doswiadczalna charakterystyka sprawnosci; doswiadczalna
zaleznos$¢ wzglednej réznicy wspoélczynnika przetwarzania przetwornicy
rzeczywistej i idealnej od wspolczynnika wypelnienia; zwiazek miedzy tymi
charakterystykami wraz z zaleznoscig teoretyczng (wzo6r na wspotczynnik
przetwarzania napiecia zawierajacy sprawnosc).

(zob. par. 3.3 i 3.4, instrukcja 0 par. 2.6.b, sprawozdanie)
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5. Korzystne i niekorzystne konsekwencje zwiekszania czestotliwosci pracy
przeksztaltnikow o dzialaniu przelaczajacym; zwigzane z tym wymagania dotyczace
przyrzadow potprzewodnikowych. Przyczyny popularnosci tranzystoréw MOSFET
mocy.

(zob. par. 3.3.f, sprawozdanie)

W przypadku wynikéw zamieszczonych w sprawozdaniu istotny jest aspekt jakoSciowy
(charakter zaleznosci) oraz orientacyjne wartosci.
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